
©2000-2014 XL Consulting GmbH, Switzerland

Synkronizer 10
User Manual



Synkronizer 102

©2000-2014 XL Consulting GmbH, Switzerland

Table of Contents

Foreword 0

Part I Welcome 6

................................................................................................................................... 61 What's new?

................................................................................................................................... 72 Editions

Part II Install, Uninstall 7

................................................................................................................................... 71 Install

................................................................................................................................... 102 Uninstall

................................................................................................................................... 103 Network Installation

.......................................................................................................................................................... 13Adding allowed workstations 

................................................................................................................................... 154 Administrative Installation

................................................................................................................................... 185 Scripted installations

................................................................................................................................... 196 Registration

.......................................................................................................................................................... 21Manual Activation 

.......................................................................................................................................................... 24Deactivate Software 

Part III Tutorials 25

................................................................................................................................... 251 Too many differences

................................................................................................................................... 302 Merge spreadsheets

................................................................................................................................... 353 Determine missing rows

Part IV Forms 41

................................................................................................................................... 411 Projects

.......................................................................................................................................................... 41Projects 

.......................................................................................................................................................... 42Files 

.......................................................................................................................................................... 42Worksheets 

......................................................................................................................................................... 44Ranges

......................................................................................................................................................... 44Databases

......................................................................................................................................... 45General information about databases

......................................................................................................................................................... 46Link data 1 on 1

.......................................................................................................................................................... 47Settings 

.......................................................................................................................................................... 47Passwords 

.......................................................................................................................................................... 49Actions 

......................................................................................................................................................... 49Highlight Differences

......................................................................................................................................................... 51Create a Difference Report

................................................................................................................................... 512 Settings

.......................................................................................................................................................... 52Main Form 

.......................................................................................................................................................... 53Compare 

......................................................................................................................................................... 53Differences betw een formulas and values

.......................................................................................................................................................... 54Filter 

.......................................................................................................................................................... 57Navigator 

.......................................................................................................................................................... 58Colors 

.......................................................................................................................................................... 58User Interface 



3Contents

3

©2000-2014 XL Consulting GmbH, Switzerland

.......................................................................................................................................................... 59System 

................................................................................................................................... 603 Navigator

.......................................................................................................................................................... 61Overview 

.......................................................................................................................................................... 62Detail Information 

Part V Project File 64

................................................................................................................................... 641 FileFormat

Part VI Problems / Errors 65

................................................................................................................................... 651 Problems / Errors

................................................................................................................................... 662 Known Problems / Errors

Part VII Visual Basic for Applications (VBA) 69

................................................................................................................................... 691 Introduction

................................................................................................................................... 702 Examples

Part VIII Object Model Reference 81

................................................................................................................................... 811 Application Object

.......................................................................................................................................................... 81Application Object 

.......................................................................................................................................................... 82Application Object Members 

.......................................................................................................................................................... 82Properties 

......................................................................................................................................................... 82ActiveProject Property

......................................................................................................................................................... 83DisplayStatus Property

......................................................................................................................................................... 83Customer Property

......................................................................................................................................................... 83EditionName Property

......................................................................................................................................................... 84VersionName Property

................................................................................................................................... 842 Project Object

.......................................................................................................................................................... 84Project Object 

.......................................................................................................................................................... 84Project Object Members 

.......................................................................................................................................................... 85Methods 

......................................................................................................................................................... 85Load Method

......................................................................................................................................................... 86Save Method

......................................................................................................................................................... 86Unload Method

......................................................................................................................................................... 87Reset Method

......................................................................................................................................................... 87Execute Method

......................................................................................................................................................... 88DoReport Method

......................................................................................................................................................... 88DoHighlight Method

......................................................................................................................................................... 89DoShow Hide Method

......................................................................................................................................................... 89UndoHighlight Method

......................................................................................................................................................... 89UndoShow Hide Method

......................................................................................................................................................... 90ProtectionRemove Method

......................................................................................................................................................... 90ProtectionValidate Method

......................................................................................................................................................... 91ArrangeWindow s Method

.......................................................................................................................................................... 91Properties 

......................................................................................................................................................... 91Settings Property

......................................................................................................................................................... 92Files Property

......................................................................................................................................................... 92Pairs Property

......................................................................................................................................................... 92Results Property

......................................................................................................................................................... 92ActivePair Property

......................................................................................................................................................... 93FullName Property



Synkronizer 104

©2000-2014 XL Consulting GmbH, Switzerland

......................................................................................................................................................... 93Name Property

......................................................................................................................................................... 93ReportWorkbook Property

.......................................................................................................................................................... 94Events 

......................................................................................................................................................... 94Progress Event

......................................................................................................................................................... 94PairActivate Event

......................................................................................................................................................... 94PairDeactivate Event

................................................................................................................................... 953 Settings Object

.......................................................................................................................................................... 95Settings Object 

.......................................................................................................................................................... 95Settings Object Members 

.......................................................................................................................................................... 96Methods 

......................................................................................................................................................... 96DefaultsLoad

......................................................................................................................................................... 96DefaultsSave

......................................................................................................................................................... 96DefaultsReset

.......................................................................................................................................................... 97Properties 

......................................................................................................................................................... 97CompareType

......................................................................................................................................................... 97CompareDescription

......................................................................................................................................................... 97Formats

......................................................................................................................................................... 98FormatsOption

......................................................................................................................................................... 98FormatsDescription

......................................................................................................................................................... 99Filters

......................................................................................................................................................... 99FiltersOption

......................................................................................................................................................... 99FiltersDescription

......................................................................................................................................................... 100FilterPattern

......................................................................................................................................................... 100FilterTolerance

......................................................................................................................................................... 100ReportType

......................................................................................................................................................... 101HighlightType

......................................................................................................................................................... 101HighlightDescription

......................................................................................................................................................... 101Show Hide

......................................................................................................................................................... 102Show HideOption

......................................................................................................................................................... 102Show HideDescription

................................................................................................................................... 1024 Files Object

.......................................................................................................................................................... 102Files Object 

.......................................................................................................................................................... 103Files Object Members 

.......................................................................................................................................................... 103Methods 

......................................................................................................................................................... 103Load Method

.......................................................................................................................................................... 104Properties 

......................................................................................................................................................... 104FileName Property

......................................................................................................................................................... 104IsValid Property

......................................................................................................................................................... 104Workbook Property

......................................................................................................................................................... 105Window  Property

................................................................................................................................... 1055 Pairs Object

.......................................................................................................................................................... 105Pairs Object 

.......................................................................................................................................................... 106Pairs Object Members 

.......................................................................................................................................................... 106Methods 

......................................................................................................................................................... 106Add Method

......................................................................................................................................................... 107AddMatched Method

......................................................................................................................................................... 107Remove Method

......................................................................................................................................................... 108ResetPairs Method

.......................................................................................................................................................... 108Properties 

......................................................................................................................................................... 108Item Property

......................................................................................................................................................... 109Count Property

......................................................................................................................................................... 109Exists Property

......................................................................................................................................................... 109Passw ordList Property



5Contents

5

©2000-2014 XL Consulting GmbH, Switzerland

......................................................................................................................................................... 110MatchInclude Property

......................................................................................................................................................... 110MatchType Property

................................................................................................................................... 1106 Pair Object

.......................................................................................................................................................... 110Pair Object 

.......................................................................................................................................................... 111Pair Object Members 

.......................................................................................................................................................... 111Properties 

......................................................................................................................................................... 111DBRow  Property

......................................................................................................................................................... 112DBKeys Property

......................................................................................................................................................... 113DBOptions Property

......................................................................................................................................................... 113RangeAddr Property

......................................................................................................................................................... 114SheetName Property

......................................................................................................................................................... 114Sheet Property

......................................................................................................................................................... 115Range Property

......................................................................................................................................................... 115Results Property

......................................................................................................................................................... 115ID Property

......................................................................................................................................................... 116Index Property

................................................................................................................................... 1167 Results Object

.......................................................................................................................................................... 116Results Object 

.......................................................................................................................................................... 116Results Object Members 

.......................................................................................................................................................... 117Properties 

......................................................................................................................................................... 117MissingTabs Property

......................................................................................................................................................... 117MissingCols Property

......................................................................................................................................................... 118MissingRow s Property

......................................................................................................................................................... 118DuplicateKeys Property

......................................................................................................................................................... 119DuplicateRecords Property

......................................................................................................................................................... 119DifferentContent Property

......................................................................................................................................................... 119DifferentFormats Property

......................................................................................................................................................... 120Sum Property

......................................................................................................................................................... 120SumByCode Property

......................................................................................................................................................... 120SummaryMessage Property

......................................................................................................................................................... 121TextDisplay Property

................................................................................................................................... 1218 Enumerations

.......................................................................................................................................................... 121muMasterUpdateID 

.......................................................................................................................................................... 121syCompareType 

.......................................................................................................................................................... 121syReportType 

.......................................................................................................................................................... 122syHighlightType 

.......................................................................................................................................................... 122syFormatsFlag 

.......................................................................................................................................................... 122syFiltersFlag 

.......................................................................................................................................................... 123syShowHideFlag 

.......................................................................................................................................................... 123syMatchType 

.......................................................................................................................................................... 124syMatchIncludeFlag 

.......................................................................................................................................................... 124syDatabaseFlag 

.......................................................................................................................................................... 124syResultCode 

.......................................................................................................................................................... 124syProgressID 

.......................................................................................................................................................... 125syResetType 

.......................................................................................................................................................... 125syErrors 

Index 126



Synkronizer 106

©2000-2014 XL Consulting GmbH, Switzerland

1 Welcome

Dear User,

Welcome to Synkronizer, the most powerful Excel comparison tool in the market.

Synkronizer will help you find differences in your Excel files. Fast, reliable and with a clear interface to

"browse" the results on screen.

But there's more:  we don't just show you the differences;  we'll help you maintain your valuable excel

data and formulas and provide you the tool to get your files back "in-sync". 

You can update missing or different data and move it from one file to the other. fully transparent and

with full control.

Comparison of Excel workbooks and highlighting of detected differences in worksheets

Project configurations can be saved to disk for easy retrieval of your favorite settings or repetitive

tasks.

Production of a user friendly difference report

Transfer of missing data and updating of differences. 

Merging of Excel spreadsheets/databases

Programmatic access with Visual Basic for Application (VBA) (developer edition only)

This manual explains how to use Synkronizer and how to effectively accomplish above tasks

In case you have other suggestions to improve Synkronizer, let us know and drop us know via the

contact menu.

Best regards,

Your XL Consulting GmbH Team

1.1 What's new?

Synkronizer 10 is a complete overhaul of the previous version.  In fact, it is almost a new software.  If

you are used to older versions of Synkronizer, the new interface is an immediate eye-catcher.  But there

is a whole lot more…
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Synkronizer 10 is a COM add-in and no longer a Microsoft Excel add-in

Projects allow you to save regular comparisons in a project file.  All your settings (choice of  files,

sheets, ranges, databases etc.) can be saved to project files.  Each project consists of one or two

workbooks and a series of pairs of worksheets, ranges or databases, as many as needed

Ranges and databases can be set per pair of worksheets, individually.  In previous versions these

options could be set  only for a single pair of tables

The Navigator toolbar has been replaced with the Navigator form.  All differences are now depicted

onscreen, intuitively presented and ready for review and update 

When differences are "highlighted" the original background color can be restored until the form is

closed. In previous Synkronizer versions, the highlighted cells' original background colors were

permanently lost.

For developers there are many new possibilities. Existing code will require a "wrapper Addin" which

provides (almost full) backward compatibility with the previous (single) function.  

Many situations where customers felt the need to write there own code should be handled by the

ability to use project files. Synkronizer 10 is now written as a Com-Addin, with it’s own object model,

and offering more flexibility to developers albeit with a completely new syntax.  Please read the

extensive help provided for developers. Can;t find the answer? Our support is happy to help with

code transition.  Feel free to contact us via the contact form on our website.

1.2 Editions

Synkronizer 10 is available in 3 "editions"

Free Evaluation Professional Developer

Range restriction A1:Z100 unrestricted unrestricted

Highlight Differences • • •

Create a Difference Report • • •

Navigator • • •

Automation (VBA access) •

Price free EUR 79.-- EUR 149.--

When you purchase a license for Synkronizer Professional or Developer Edition you'll receive a

"registration key" which is then sent to our "Activation server" that verifies that the registration key is

legitimate and not used by anyone else.

2 Install, Uninstall

2.1 Install

Installation
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Synkronizer 10 is a COM add-in for 32-bit versions of Excel 2010 (32 bit), 2007, 2003 and XP. 

It works on 32 bit and 64 bit versions of Windows (XP thru Win7)  if you install 32 bit Office/Excel.

Synkronizer 10 does NOT work with the 64 bit version of Excel 2010. 

In order to install the application proceed as follows:

1. Download the latest version of Synkronizer.

2. Log-in to Windows using an account with administrator rights

3. Double-click the installation file SetupSynkronizer.10.X.xxx.exe

4. Follow the instructions...

5. Done.

Start Excel 2010/2007: You'll find the Synkronizer 10 icon in the "Review" tab 

Start Excel 2003/2002(XP): You'll find the Synkronizer 10 icon in the "Tools" menu

Type of installations

There are three different installation methods:

Standard Installation

This installation method is used for single-user licenses.

Network Installation

Standard Installation PLUS a shortcut to a shared network license file. Only for users/companies

who purchased a special NETWORK LICENSE KEY. 

This installation is designed for corporate networks. Workstations need PERMANENT access to the

license data which is stored on the network share.

During the installation you will be asked to specify TWO directories:

the INSTALLATION directory where the program files will be installed. (preferably on the local

disk).

the NETWORK directory where the license file is located.  This MUST be an existing directory.

An empty license file will be copied here when it doesn't exist. 

(a shortcut to the network license file will be placed in the installation folder).

Administrative Installation

Standard Installation PLUS a shortcut to a shared license distribution file. Only for users/companies

who purchased a MULTI-USER LICENSE KEY.

This installation method is designed for system administrators in companies which have multi-user

licenses. Workstations need ONETIME access to obtain registration data which is then stored on the

local disk.

During the installation you will be asked to specify TWO directories:

the INSTALLATION directory where the program files will be installed. 

the DISTRIBUTION directory where the license distribution files are located. This MUST be an

existing directory. Empty license distribution files will be copied here when they don't exist.

(a shortcut to the distribution folder will be placed in the installation folder).

Scripted Installations

the setup executable accepts command line switches for use in scripted installations or batch files. 

The syntax is described in this chapter.
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Administrator Rights

The user who performs the installation MUST have administrator privileges.

Network Installation

The user who performs the installation MUST have administrator privileges.

The user who registers and activates the license and/or wants to add/remove nodes(workstations) must

have WRITE/MODIFY permission to the license file on the network share. 

if the workstation is already registered in the file the user for that computer needs READ permission to

the license file on the share. 

Administrative Installation

The user who performs the installation MUST have administrator privileges.

The user who maintains the License distribution files must have WRITE/MODIFY permissions to files on

the network share. 

The user of the local computer needs READ permission to the license distribution file on the share. 

Problems 

Setup should run without problems.  However the infamous "User Account Control" does make life

difficult in some cases.

If you are on a corporate network, go to your administrator. If you are on a home PC or laptop and

setup doesn't complete as expected, or synkronizer reports "initialization" errors on startup, some

"manual" work may be required. 

Dependencies

Synkronizer setup assumes the VB6 runtimes are installed. These are pre installed on Vista and

Windows7, but could be missing on (older) Windows XP installations.

If not installed you'll find them here:  Search Microsoft.com

Synkronizer setup installs some Dll's and Ocx files to the install directory, which it attempts to register

with RegSvr32. RegSvr32 may fail if your login account doesn't have Administrator Privileges, or if "User

Account Control" in Win7/Vista prevents access. We need to open a "console" with admin rights..  To

do that we must create a shortcut to cmd.exe with some extras.

Right-click the desktop. Select menu New. Select menu Shortcut. Type cmd.exe. Follow instruction

and the shortcut is created. 

Right-click the shortcut. Select menu Properties. Select tab Shortcut. Select the button Advanced.

Check Run As Administrator. Click OK twice to close the dialog.

Now double-click the shortcut. You should get a warning from User Account control. You must

accept.

Navigate to your installation directory and use regsvr32 to "register" the files.
c:
cd \program files\synkronizer  (or program files (x86)\synkronizer
cd synkronizer 10.0
regsvr32 synk10.dll
regsvr32 synklic.dll
regsvr32 Codejock.Controls.ocx
regsvr32 Codejock.ReportControl.ocx
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2.2 Uninstall

Uninstall

Synkronizer 10 is a COM-Addin.  It takes very few resources and time during startup, so you can leave it

enabled and available for direct use. 

It depends on several other components and these must also be properly (un-)installed. So please do

not simply delete the folder.

Should you decide to remove Synkronizer from your computer, then proceed as follows:

Uninstall via Control Panel

1. In Windows, open the Control Panel

2. Select "Programs and Features" (Windows 7, Vista) or "Software" (Windows XP)

3. Select "Synkronizer 10" and click on "Uninstall"

Disable Synkronizer in Excel

You can also disable Excel loading the Synkronizer Addin during startup. The Addin requires very little

time or resources so this is not recommended.

However it's your choice:

Excel 2010/2007

1. Choose Start » Excel Options

2. Select the add-ins menu

3. With the drop-down button, select COM Add-ins

4. Remove Synkronizer 10

Excel 2003/XP

A bit more complex as the ComAddins menu item is not installed by default.

1. Select the menu command View » Toolbars » Customize

2. Select the Tools category

3. Search "COM Add-ins ..." in the Commands list

4. Select the COM add-ins ... with the mouse and move it into the Excel Tools menu

5. Close the Customize window

6. Select the menu Tools » COM Add-Ins ...

7. Remove the check of "Synkronizer 10"

2.3 Network Installation

Application

Only in case you have purchased a network license (registration key) the files needed by the application
can be installed to a shared network drive, although it is not mandatory. The network license file must be
installed on a shared network drive.
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The network license

The network license file is a single file located on a shared folder which contains the registration key for
the edition(s) you purchased. That license file will be activated once (and locked to the server/path).  The
client PC’s can then be allocated or removed based on their network name, without further need for
activation.

Initial Installation

1. Create a shared network drive.

2. Install the software using the method "Network Installation".

3. Then select the network folder in which the license should be copied. Note: Synkronizer requires a

UNC path.
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4. Complete the installation.

5. Start Excel and Synkronizer.

6. Register and activate the software

7. Add the workstations which are allowed use Synkronizer (see below)

Installations on workstations

The installation on the workstations is very easy. Perform a network installation and select the network

directory, which contains the license file. If the software is activated and the workstation is assigned, the

user can work with Synkronizer immediately.

Schema Network
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The license file (license.xml, red) is located on a shared folder.

The installation folder of the Synkronizer users contain a shortcut (license.lnk, blue) to the license file.

Permissions

At least one user must have write/modify permission on the license file, while all others only need read
permissions. The user(s) with write permission can register/activate the license and manage the list of
allowed computers.

2.3.1 Adding allowed workstations

Once the license is registered and activated it is necessary to add the workstation(s) to the list of
allowed computers.

This can be done from any computer where Synkronizer is installed. (Note that the install folder must
contain a shortcut to the network license file and the user making the changes must have write
permissions.)

1. Start Synkronizer.

(also shown when you select the menu Project » Settings... » System » Registration/Activation)

2. Click the "Manage" tab.

3. Select workstations in the "Category" dropdown and the edition in the License "dropdown".

4. Now you can enter the computers/users which are allowed to work with Synkronizer. Just enter the
correct computer names (and optional description) in the input fields and click on the "+ Plus" button.
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The allowed computer will then be added to the "allowed" computer list.

Add a series of workstations

You can prepare a list of workstations (and descriptions) and paste it into the application. The list can

be created from a script or typed in a text editor or excel worksheet. Proceed as follows:

1. Start Excel

2. Create a list with the workstation names and users

3. Select and copy the list
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4. Open the "Manage" tab of Synkronizer

5. Press "Paste". The list is filled (with a maximum number of licensed computers)

Changing / editing

Items in the list cannot be edited or changed. If a name or description is wrong, remove the existing

item and then add the item with the correct text.

2.4 Administrative Installation

Definition

This installation method is suitable for the installation of multi-user licenses. In a distribution file, the

administrator defines the COMPUTERS (by their bios computer name) and the LICENSE KEY they will

use.

During installation, the user must select the folder containing the distribution files. A shortcut to this
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folder is then placed in the installation folder. 

When the user starts the Synkronizer program it will first look in the install folder for a valid license file.

If it fails BUT it does find a LicenseDistribution shortcut it will then lookup the computer name in the

distribution file and read the associated registration key. Then it contacts our activation server and

creates a local license file.

Initial Installation

1. Install the software using the method "Administrative Installation".

2. Then select the directory in which the distribution files to be copied.

3. Complete the installation.
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4. Open the file "LicenseDistribution Manager.xlsm".

This file contains all relevant data set, which is necessary for the installation on the workstations. The

following chapter describes how the data must be entered.

File LicenseDistribution.xml

This file is being read by the workstations. 

It can be edited with any XML editor, but we've provided an excel file for your convenience.

File LicenseDistribution Manager.xlsm

This Excel file is just an editing tool for the xml file listed above: e.g. the tables in the Excel file are

mapped to the XML 

and provide a convenient way to edit and maintain the actual xml data. 

DO NOT FORGET TO EXPORT THE XML FROM THE EXCEL FILE

Table Licenses

The license data can be entered in this table. Enter the following data:

ID Unique identifier for the license (eg, PRO10, DEV5). This ID will be used in the table

machines.
key Registration key of Synkronizer
count Number of licenses
question Number of the security question (required for software activation)
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answer Answer of the security question
comment Optional comment

Table Machines

This table defines the workstations, computers or laptops, on which Synkronizer is to be installed. The

following fields are available:

computer

name

Name of the computer to be installed Synkronizer. The computer name must be unique, if

not the installation fails later.

license Identifier or ID of the license, which is entered in the first column of Table Licenses.

number Unique number of the license. If for example a ten-user license is present, the numbers

one through ten must be entered in this column.

comment Optional comment

Once the data are entered, save the excel file AND click on the button "XML export." 

This generates the distribution file in the same directory. To export to a different directory or file use

standard excel xml export (form the developer tab).

TIP for computers that wont be connected to your network during first use...

You could create a LicenseDistribution file for each computer and save them under separate names.

Then EITHER: copy the actual xml file to the local installation folder as "LicenseDistribution.xml"  

OR: create/edit a windows shortcut file named "LicenseDistribution" pointing to the

generated file.

Install licenses on computers

To enable the installation on the workstations / computers / laptops, make sure that the license file is

on a shared directory (alternatively, the distribution files are to be included in the installation packet). If

this is the case, then install the software using the method "Administrative Install". In the step "Select

directory for distribution license," you must select the directory in which contains the license files. The

software is then activated and registered as soon as Synkronizer is started.

Once the Synkronizer program has been started and successfully activated the license info is stored in

the local computer's license.xml and the shortcut or distribution file can be deleted.

2.5 Scripted installations

Following are the custom command line switches accepted by the setup executable

Choose the installation type /TYPE=

must be one of the following (upper or lowercase)

standard

network

distrib

Set the network or distribution folder /FOLDER=

a valid file path or URL for the network folder, e.g.:

X:\folder\subfolder
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 \\server\share\folder\subfolder

ignored for type=standard

required for type=network or type=distrib

can be included in single or double quotes

Set the installation folder /DIR=

a valid file path or URL for the installation folder, e.g.:

C:\Program Files (x86)\Synkronizer

default: {pf32}\Synkronizer\Synkronizer 10.0 

Minimize user interaction /SILENT

No output or messages /VERYSILENT

Create a log in the temp directory /LOG

There are other parameters available, which are described in the following link:

http://www.jrsoftware.org/ishelp/index.php?topic=setupcmdline

Examples:

Standard Installation

SetupSynkronizer.10.x.xxx.exe /TYPE=standard /silent

Network Installation

SetupSynkronizer.10.x.xxx.exe /TYPE=network /FOLDER=x:\my folder

Administrative Installation

SetupSynkronizer10.x.xxx.exe /TYPE=distrib /FOLDER=x:\my folder

2.6 Registration

When you purchase a license you will receive a "registration key" for the edition you bought. This

registration key is used to "register" and "activate" the software. The activation process is fully

automated, it only needs an internet connection. It can also be done via email if firewall settings prevent

the program's direct communication with our server.

What happens during the activation process?

The registration key and some hardware codes is sent to our activation server, which returns one or

two activation codes. The activation codes received from the server should "match" the codes sent and

will then be stored in the license file. The license file is now uniquely coupled to your PC and your

software is activated. 
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Network Installation

Before you can activate a network license, you'll need to create a share folder on the network drive.

Please study this chapter.

To start the activation process: 

1. Start Synkronizer. The startup screen appears

(also shown when you select the menu Project » Settings... » System » Registration/Activation)

2. Press "Register". The following form appears:

Enter the registration key and press "Validate".
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Multiuser License:

If you should install a multiuser license, an additional input field is displayed next to the registration

key field (see below picture). This field contains the license number (sequential number from one to

the number of purchased licenses). Be aware, that you enter in that field a number which not has be

entered yet.

3. Please enter then the secret question. Click "Activate".

Note:

The security answer is an additional safeguard so that no one else can use your license. If you want

to install your license on a second PC, you need to enter the same answer. The secret answer must

be at least 5 characters long. The following characters are allowed: A-Z and 0-9.

4. The registration data is now sent to the activation server and the software is activated.

If you should have no internet connection, you'll need to activate manually. Please read the chapter

"Manual Activation".

If you have any problems with the registration/activation process please read the chapter Problems

with registration.

2.6.1 Manual Activation

If no internet connection is available, the software needs to be activated manually via the Synkronizer
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Activation Server.

This chapter explains how you can manually activate Synkronizer.

The registrations steps 1 to 3 are explained in the chapter Registration.

4. The "Manual Activation" screen appears, which contains the datrastring to be submitted to the
activation server.

5. You'll need now to copy the datastring to a text document (e.g. Notepad).

Open for this a textdocument and paste the datastring using the keys "CTRL-V".

6. Open the internet and enter the following link:

http://www.synkronizer.com/scripts/activate.php?lang=en

The software activation page is displayed:

7. Paste the datastring in the input field 1) and click on the activate symbol:
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8. Note the activation key and return to the license form of Synkronizer:

9. Enter the activation key in the input field and press "Enter".

10.The software is now activated.
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If you have any problems with the registration/activation process please read chapter "Problems with

registration".

2.6.2 Deactivate Software

If you should purchase a new computer or should have problems with your current computer, you can

transfer your license anytime to another computer. Just deactivate the license from the old computer

before you can activate it on the new one.

Proceed as follows:

1. Start Synkronizer.

2. Select Project » Settings... » System » Registration/Activation.

The welcome screen is displayed.

3. Select the tab "Manage".
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4. Click "Deactivate".

5. The software is deactivated.

If you should have no internet connection, you'll need to deactivate the software manually. A manual

deactivation works exactly the same like the manual activation. The opnly difference is, that you'll get an

unlock key instead of an activation key. Read this chapter for manually deactivating the software.

".

3 Tutorials

This section contains some tutorials to get  familiar with Synkronizer:

1. Too many differences

2. Merge spreadsheets

3. Determine missing rows

3.1 Too many differences

This tutorial explains how to minimize the number of differences using the filter function.

When comparing cells Synkronizer first looks at the data type of the cells (Numbers/Text/Date/Boolean/

Error etc) and only then compares the actual content.  If the data type and the content are not

completely equal a difference will be reported.  

Sometimes this is too precise for your purpose and you get too many differences..  e.g. you don't care

about differences like  "Customer" and "CUSTOMER" or 123 and "123"



Synkronizer 1026

©2000-2014 XL Consulting GmbH, Switzerland

Then you can use Filters to instruct Synkronizer to be less precise. This page will show you how to do

that.

1. Download the example files from the webpage:

http://www.synkronizer.com/files/examplefiles.zip

2. Extract the zip file and copy the Excel files to a folder of your preference.

3. Open Excel and start Synkronizer.

4. Select the files Master.xls and Update.xls.

5. Select the worksheets "TDM1" and "TDM2" and start then the comparison process.

6. The Navigator form is displayed which determined 500 differences:

7. As you scan see from the first couple of differences the data in the first files is "Proper" in the other it

is "UPPER". 

8. Let's set a filter to "Ignore the case".  Open the menu Project » Settings.
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9. On the form Select "Filters".  First check "Enabled" then check the Option "Ignore Case"

Close the form by clicking the Ok button.

10. You go back to the Navigator form. Click the Button "Run the comparison again" (2nd button in the

top row, see cursor)
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11. We now have 396 differences left.

12. Closer inspection will show that the differences in Column B are caused by trailing spaces in the

"Update" file. 

 Repeat the steps 7-10  and add a check next to the filter option "Trim Whitespace".  You should now

have 297 differences left.
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13. Now look at the differences. You'll notice that some cells are displayed with the @-sign. This is an

indicator for cell content that is stored as text but can be converted to a Number, a Date or a

Boolean. These differences can be filtered by ignoring the data type.

Repeat the steps 7-10  and add a check next to the filter option "Ignore data type".  You should now

have 99 differences left.

[Remark: Ignore Datatype will only work if the text can be converted using the current system

locale (regional settings)]
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14. We now have only differences in column E remaining. You'll quickly see that the numbers in Master

are rounded, but the numbers in Update are not.(although in the worksheet the extra precision is not

displayed due to a number format). These differences can be ignored by setting a numeric tolerance.

 Go to the Filters page on the Settings form and set a value of  0.01 in the box for "Numeric

Tolerance".  

15.  No more differences found!

3.2 Merge spreadsheets

This tutorial explains how to merge different Excel spreadsheets.

1. Download the example files from the webpage:

http://www.synkronizer.com/files/examplefiles.zip

2. Extract the zip file and copy the Excel files to a folder of your preference.

3. Open Excel and start Synkronizer.

4. Select the files Master.xls and Update.xls.
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5. In the section "Worksheets" select the worksheets "Customers 2009-10-31" and "Turnover". Now click

then on the checkbox (see cursor below).

The worksheets are added to the worksheet list.

6. In order to activate the database modus you need to double click on the worksheets or click on the

database symbol (see cursor).
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The options frame is now open.

7. Click "Enable DB mode" and select the primary key. Apparently, the Fieldname drop-down is empty

(see cursor below). This means that no identical field names were found.

For more information about the behaviour of databases and primary keys, please read chapter 

General information about databases.
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8. Close the Synkronizer form and check the field names of the files. Their databases have different field

names ("Customer No." and "Customer #"). Change the caption of the spreadsheet "Turnover" to

"Customer No.". Now you have an identical primary key!

9. Restart Synkronizer and select the database mode. You are able to select the primary key. Confirm

the fieldname "Customer No." with a check (see cursor below).

10.Check "sort records" and start the comparison process (see cursor).
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11.The Navigator form is now displayed. As you can see there are 4 missing columns in Master file and

12 missing columns in the Update spreadsheet found (see highlighted cell below).

12.Now we want to merge the spreadsheets by transferring the missing columns from Update to the

Master-spreadsheet. If you want to transfer just one column, click on the desired column and the

transfer button (see illustration below).
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13.Alternatively, you can transfer all columns by one click. The corresponding button is shown in below

illustration.

The spreadsheets are now merged. You can close the Navigator.

3.3 Determine missing rows

This tutorial explains how missing (or different) rows of two Excel spreadsheets can be
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recognized.

When you are working with large sheets, your differences can be "all over the place". With the navigator

you can "jump" from one difference to the next but you want overview, and concentrate on (for

instance) the rows that were added or deleted. 

Synkronizer allows you to only display specific differences(e.g. missing rows) and blend out the

remaining parts, so your differences appear together on your screen.

This page will show you how to efficiently use the "Show/Hide" tool.

1. Download the example files from the webpage:

http://www.synkronizer.com/files/examplefiles.zip

2. Extract the zip file and copy the Excel files to a folder of your preference.

3. Open Excel and start Synkronizer.

4. Select the files Master.xls and Update.xls.

5. In the section "Worksheets" select the worksheets "Customers 2009-10-31" and "Customers 2009-11-

30". Now click then on the checkbox (see cursor).
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The worksheets are added to the worksheet list.

6. In order to activate the database modus you need to double click on the worksheets or click on the

database symbol (see cursor).

The options frame is now open.

7. Click now "Enable DB mode" and select the primary key "Customer No." in the list box "Fieldnames".
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Add the primary key with a check (see cursor).

For more information about the behaviour of databases and primary keys, please read chapter

"General information about databases".

8. Click on "Group records" (this ensures that all missing rows are grouped together).

Start the comparison (see cursor above.)
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9. The Navigator is now displayed. As you can see, Synkronizer found 5 different rows in the Master file

and 7 different rows in the Update file (see cursor, caption 5/7).

10.If you like, you can now update the worksheets (transfer differences from left to right or vice versa).

For this, just select the desired differences and click on the update buttons (see cursor below).

11.If you prefer to show the missing rows only, click with the cursor on the arrow of the "Show/Hide"-
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symbol and select all columns and "Missing rows". Click then on the "Show/Hide"-button (see cursor

below). The rows will be hidden and/or displayed now.

12.You can see the missing rows only (and all columns).

13.When you close the Navigator form you will be asked if the Synkronizer highlighting should be

removed or not. Press "No". 

Note: the default response to this dialog can be set in Settings..
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4 Forms

4.1 Projects

Synkronizer is started as follows:

Excel 2007

Menu Reviews » Synkronizer 10

Excel XP, 2003

Tools menu » Synkronizer 10

The main form of Synkronizer 10 appears

In this form, the main settings are set.  Further settings are set in the form Settings

4.1.1 Projects

A project holds a configuration of files, pairs of worksheets and settings (filters etc).  Project files can

be saved so you can easily manage your recurring comparisons.

The following commands are available from the Projects Menu:

New

Clears the main form.  Settings revert to the defaults specified in settings, files and pairs are emptied.

Open

Opens an project file from disk and loads the files, pairs and settings.
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Save

Saves current settings as a project (including the selection of the Excel files)

Save as

An existing project or current settings can be stored as a new project under a new name

Note

Important, by default passwords are not stored in the project file.  For more detailed information

please study the chapter Passwords

4.1.2 Files

In the main form the files to be compared are selected.  This step is performed for each file by clicking

on the "open file" icon.  Alternatively, the files can also be selected with the drop-down buttons.  If you

click that button a list of all recently compared and recently opened Excel files appears

Projects

Files can also be opened by the use of a project using the menu (Project » Open). For more detailed

information see  chapter Projects.

Supported file types

All files, which are supported by Microsoft Excel can be opened with Synkronizer 10

4.1.3 Worksheets
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This form lists all worksheet "pairs" that are to be compared.  The worksheets can be paired

automatically or manually

Match / remove worksheets automatically

The following buttons are available to add / remove the worksheet couples:

All worksheets of the workbooks are matched by name

All worksheets of the files are matched by index

The first worksheets of the files are matched

All worksheet pairs are removed from the list

Match worksheets manually

The worksheets can be matched manually.  This is done in the header of the worksheet list box:

 

In the row marked with a star, there are two drop down-boxes (see illustration).  With these fields the

required worksheets can be selected.  The selection has to be confirmed by selecting the checkbox to

the right and the pair of worksheets will be included in the list

Remove worksheet pairs manually

If you do not want to compare all pairs of worksheets, you can remove the unwanted pairs with the

"Delete" button.  As a further option, the worksheet "couples" can be removed by clicking with on the

checkbox at the right side (see picture below)

 

Once the box is unchecked, the worksheet "couple" disappears from the list

No worksheets found
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If no worksheets are available in the drop-down lists, the worksheets are either protected, empty and/

or hidden.  In this case, you need to change the display mode for worksheets.  For more detailed

information please refer to the chapter Settings » Main Form

4.1.3.1 Ranges

If you do not want to compare the entire table, you can define the desired range.  Proceed as follows:

1. Select the worksheet which contains the range you want to compare

2. Select the button "Edit ranges and database options" (icon to the right) or double-click on the pair

of worksheets you want to edit.  The option field appears

3. Select "Edit ranges" to set the desired range

4. The range icon is now displayed to the right of the worksheet

Note:

You can also enter named ranges. Multiarea ranges are not allowed.

4.1.3.2 Databases

If the worksheets you want to compare are in a database structure, we recommend to employ a

database comparison. If you do not know exactly what is a database and how it works, please read first

the chapter General information on databases
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Proceed as follows to enter the database options:

1. Select the worksheet "couple" containing the databases

2. Select the button "Edit ranges and database options" (icon to the right) or double-click on the pair

of worksheets, which must be edited.  The option field appears

3. Click "Enable DB mode"

4. Select with the field "Row for headers" the row on which there are the field names in the database

(normally row 1)

5. Build the primary key using the DropDown "Fieldname".  Confirm the selection by clicking on the

checkbox.

Important:

The field names must have identical names, otherwise the database can not be linked!

6. The database icon appears in the worksheets list

In addition the below options can be selected

Sort records

The data is sorted by the primary key

Group records

The data is sorted by the primary key, but grouped. First, the linked records are listed, then the added/

deleted rows and last but not least the duplicate keys/records

Add SynkID

To the right of the databases a new column entitled "SynkID" will be added.  This column contains the

various difference types.  You can then sort and/or filter (auto filter) the databases by the differences

types.  The following captions are written in the SynkID column:

0-Key Duplicate key

0-Dup Duplicate record (redundant record)

1-Rec Missing row

2-Val Different cell value(s)/formula(s)

2-Fmt Different cell formatting(s)

4.1.3.2.1  General information about databases

Prior to describing the types of differences we want to give a brief definition of "normal" worksheets

versus a database

"Normal" worksheets

do not contain column headings and no database structure.  For such worksheets, Synkronizer

performs a cell-by-cell comparison.  As a frequent user of Synkronizer you will soon learn that the data
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comparison of a "normal" worksheets is not as efficient as a database comparison

Databases

are worksheets that contain data within a database structure.  The data must be arranged as follows:

The first row contains unique column names 

The database contains one (or more) column(s) with primary key(s) (unique identification number,

article number etc.).  A primary key uniquely identifies each data records and facilitates the sorting

and synchronizing of your data.  The primary key does not need to be a single field (e.g. employee

number).  It can be constructed with multiple fields (e.g. family name, first name and city) to create a

unique identifier and avoid duplicate keys/records

Below paragraphs describe the difference between a 'duplicate key' and 'duplicate records'

Duplicate keys

Duplicate keys are data records, which contain the same primary key.  Assuming the primary key is

formed from the family and first name, if you have several customers called "John Miller" in your

database, Synkronizer will not know which data records should be compared.  Make sure you operate

with unique primary keys when working with Synkronizer

Duplicate Records (Redundant records)

Synkronizer also checks whether your database contains duplicate records (or redundant records). 

These are records where all fields (not just the key fields) are equal.  If found these records will be

highlighted in gray.  Duplicate records do not serve any purpose and should be deleted 

The comparison of "databases" is a fast.  The databases may be sorted or altered.  The inserting and

deleting of columns and rows is allowed.  Synkronizer will recognize all differences between the two

files

4.1.3.3 Link data 1 on 1

If you are sure that your worksheets contain no deleted or inserted columns/rows, you can check the

fields "Link 1 on 1 for columns/rows". This overrides the linking algorithms.

Proceed as follows to link the data 1 on 1:

1. Select the worksheet "couple" containing the desired data
2. Select the button "Edit ranges and database options" (icon to the right) or double-click on the pair

of worksheets, which must be edited.  The option field appears
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3. The following checkboxes appear

Link Columns 1 on 1 and

Link Rows 1 on 1

4. Click on the desired checkboxes and start the comparison.

4.1.4 Settings

In the main form the most important information such as files, tables, etc. is defined.  If you

want to define additional information, you have to open the Settings form.  The Settings form

can be opened with the menu command Project » Settings or the button depicted on the left

For more detailed information please refer to the chapter Settings

4.1.5 Passwords

Password-protected worksheets can be compared and a difference report can be created, but

the differences can not be highlighted, hidden or transferred.  These actions can only be

executed when you enter the passwords of the protected worksheets.  To enter the passwords

just click on the button shown to the left.  The following forms appears
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In this form, all password-protected worksheets are listed.  In the bottom of the form the required

passwords can be entered.

Test passwords

With the "Test"-button, you can check whether you entered the correct passwords.  If you have entered

the correct passwords, the locks will be replaced by a key in the symbols (see the first pair of

worksheets)

Passwords in projects

By default passwords are not saved in the project file.  If you do want to store passwords in your

projects you have to change a registry setting. Note that passwords are not stored in readily legible

form, but the obscuring routine is not difficult to reverse engineer. If you want the convenience of

storing passwords with your projects, you have to open the registry and select the following key:

HKEY_CURRENT_USER\Software\Synkronizer Software\Synkronizer\10.0

Select the entry ProjectsPasswords and change the value to 1.  The passwords will now be stored

(and loaded) when you save or open a project file.

Problems with password-protected worksheets

Protected worksheets can be compared without a password and without problems EXCEPT when

they contain cells that have the "Hidden" checkbox on the Protection tab turned on. In this case

Synkronizer MAY return inaccurate results because not all cell information can be read correctly.

With the unlocking of these worksheets (potential) problems can be avoided.

Also note that the Navigator may not be able to highlight, select or update cells or ranges if the sheets
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are protected and password is not provided. 

4.1.6 Actions

If you have set all comparison options, you can determine what actions you want Synkronizer to

perform.  The following two buttons are available:

Highlight Differences (left button)

With the left button it is determined whether differences are to be highlighted or not.  The following

options exist:

No Highlighting: No differences are highlighted

Highlight Differences: The differences are highlighted in the worksheets

Clear and Highlight: The differences are highlighted in the worksheets.  Before highlighting all the

background highlighting are removed.

Create Difference Report (right button)

With the right button, you can specify whether a difference report should be created.  The following

options are available:

No Report: No difference report is generated

Difference Report: An Excel difference report is generated

Hyperlinked Report: An Excel difference report with hyperlinks is generated

XML Report: An XML difference report is generated.

If all settings and actions have been taken, the comparison of the worksheets can be started

with the button shown on the left

4.1.6.1 Highlight Differences

If you choose this action the differences in all underlying worksheets are highlighted:
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The differences are highlighted in the following colors:

light blue for deleted columns/rows

light green for added columns/rows

yellow for different cell values/formulas

orange for different cell formattings

lilac for duplicate keys (only database mode)

gray for duplicate records (redundant records) (only database mode)

At one glance Synkronizer clearly displays all differences and you can decide with which version of the

worksheet you wish to proceed

The colors listed above are the default values, you can specify your own color settings, see the chapter

Settings » Colors

Cells with Conditional Formattings

If Synkronizer finds different cell values (or formulas) in cells with conditional formatting, then the cells

can not be marked. In this case, Synkronizer draws a diagonal line in the corresponding cell
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4.1.6.2 Create a Difference Report

If desired, you can display the result of the comparison in a reader friendly difference report.  On this

report you see the rows or columns deleted and/or added, and each cell with a different value.  The

difference report displays the values entered in worksheet 1 and worksheet 2.  This report is a great

help in tracing differences and updating your Excel files.

4.2 Settings

In the settings form the remaining settings be defined.  See below sections for descriptions of the

various settings

Save/Reset Preferences

You can configure Synkronizer to your needs.  With the buttons "Save Preferences" and "Reset

Preferences" you can save or reset the settings to the default set-up

Differences between Application and Project Settings
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In this form you can define application and project settings.  Below are the differences of those

explained

If no project is active, the application settings are displayed in all forms

If a project is active, the first three menus (Main Form, Compare and Filter) contain the project

settings, in the other menus the applications are displayed

If settings are changed in the first three menus and you press then the 'Ok'-button, these settings are

saved in the project.  Changes in the other menus have no effect on the projects

4.2.1 Main Form

On this page, the default values of the main form can be defined.  You can determine how the main

form should behave when Synkronizer is started or a new project is opened

Select how sheets are matched:

Here you specify how the worksheets should be matched when a new project is created

Select to include in selection and lists:

In this section you can determine which worksheet types can be compared.

Actions: Highlight differences / Create difference report:

Use these buttons to set the actions to be executed by default.

Important:

If no project is active (or empty), the default settings are displayed.  If a project is active then the

project settings are shown



Forms 53

©2000-2014 XL Consulting GmbH, Switzerland

4.2.2 Compare

In this form, you can specify how Synkronizer shall compare the worksheets

Compare cell contents

Here you can determine whether Synkronizer compares the data by formulas or values.  If you do not

know the difference between these comparison types, please first read the chapter "Differences

between formulas and values"

Compare cell formatting

If cell formats should be compared, you can select the desired format by clicking the appropriate check

boxes

Comments on the use of comparing cell formats:

Only cell formats within the data range is compared

The comparison works properly only if both files use the same style

The comparison by format slows the comparison process

Important: If no project is active (or empty), the default settings are displayed.  If a project is active

then the project settings are depicted

4.2.2.1 Differences between formulas and values

Below example illustrates the difference between values and formulas.  The sales for the month of

January changed from US$ 10.00 to US$ 10.50.  Therefore the turnover of the 1st Quarter raises also
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from US$ 30.00 to US$ 30.50.

Comparison by Formulas

If you compare the worksheets by formula, only the month of January is recognized as a difference,

because the cell 1st Quarter contains an identical formula

Comparison by Values

If, however, a comparison by values is performed, Synkronizer recognizes two differences, as the month

of January and the 1st Quarter have different values

4.2.3 Filter

In this area you can determine whether you want to apply a filter to the data or not
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You can define multiple filters by clicking on the desired check boxes.  With the checkbox "Enabled" the

filters will be activated.  Important: If you have selected filters, but "Enabled" is not checked, the cell

values/formulas are not filtered.

Ignore case

If this field contains a check, Synkronizer ignores differences between small and capital letters (e.g.

"John Miller", "JOHN MILLER").

Trim whitespace

If you select the "Trim whitespace" option Synkronizer removes spaces at the beginning and end of the

cell entries and comments before comparing them. Thus "John Miller" and "John Miller   " (with trailing

spaces) will be considered the same. You can use this to ignore the differences between empty cells

and cells with spaces only

Ignore datatype

It is possible that the numbers are formatted in a one worksheets as a number, in the other as text. 

With this option, these differences are ignored.

Note: If date values are shown in one worksheet as date and in the other as a number, then these are

formatting differences. These differences can by recognized with the setting Compare » Compare cell

formatting » Number

Ignore cells with constants / formulas

If one of these options is active, all cells with constants (values) or formulas are ignored

Ignore hidden columns / rows
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If  you click on these check boxes, the hidden columns and/or rows are not compared.  Obviously, this

option is only effective if the columns/rows in both tables are hidden

Numeric Tolerance

Normally numeric tolerance is 0.  All differences between numeric entries are reported.  Synkronizer

allows you though to ignore small differences.  Set numeric tolerance to 0.01 to ignore differences of 1

cent or smaller

Text Filter

With a text filter you can choose to ignore specific differences.  Choose between VBA's 'like' operator

or a RegEx pattern for Microsoft VBScript Regular Expressions (if installed on your system)

Following are a few examples of how to use a TextFilter:

In a project file the cells with 'Done' should be ignored. 

Syntax: Like. TextFilter: 'Done' (or [Dd]one if you want)

In a project file the cells with 'Todo' or 'Done' should be ignored.

Syntax: RegEx. TextFilter: 'Todo|Done'

In a database the fields with 'New York' or 'Los Angeles' should be ignored.

Syntax: RegEx. TextFilter: 'New York|Los Angeles'

Note: Case sensitivity for text-filters depends on Ignore Case option.  If you want to filter a date, then

you must enter the numerical value of the date, e.g. the 1 January 2010 corresponds to the number

40179

Important: If no project is active (or empty), the default settings are displayed.  If a project is active

then the project settings are shown
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4.2.4 Navigator

Show/hide

When enabled Synkronizer shows or hides selected entries after comparison

Allow overwriting data by empty cells

If this option is selected all differences are updated.  Unselect this option to prevent cell contents being

overwritten with blank (empty) content from the other file 

Use entire rows / columns when inserting / deleting

Normally only the rows within the data range are inserted/deleted by transferring/deleting rows (or

columns). If this checkbox is active, the whole row/column are inserted/deleted

Remove highlighting on exit?

Here you can specify whether Synkronizer highlighting shall be removed or not when you exit the

Navigator.  The following options are available:

Ask to undo highlighting on exit: A message box appears whether Synkronizer should remove the

highlighting.

Never undo highlighting on exit: The highlightings remain preserved

Always undo highlighting on exit: The Synkronizer highlightings are removed when closing the

form, with the old background colors restored.  Your background colors won't be lost!
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4.2.5 Colors

In this section you can determine the colors with which Synkronizer highlights the differences. In

addition, you can customize the colors of the difference report

4.2.6 User Interface

Arrange Excel windows

Here you can determine whether the worksheets should be tiled vertically or horizontally

Appearance of forms
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With this drop down field you can determine how the layout of the forms (background, buttons, etc.)

should look like.  Synkronizer offers a number of different layout styles

Excel menu options

If you select this check box, the Synkronizer icon appears on the Standard toolbar of Excel

Language

With this field you can specify the language.  Important: If your language is not included, we offer a

developer version for free, if you translate the language of the Synkronizer GUI (Graphical User

Interface) to a not yet available language.  Please contact us via the contact form to receive detailed

instructions

4.2.7 System

In this area the system will be set

About Synkronizer

In this window, the Synkronizer version information is provided

Registration/Activation

Click this button to activate or upgrade the software

Folder for projects

In this directory, the project files are saved or opened
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Clear most recently used lists

If you click on these buttons the recently opened files and projects will be deleted

4.3 Navigator

After completion of the comparison process the worksheets are displayed vertically or horizontally and

a user-friendly form is displayed.  This form, the navigator, allows you to navigate through all

differences

Synkronizer displays both worksheets next to each other and as such lets you compare the differences

directly.  At this point you may decide with which version you wish to continue.  With mouse-clicks you

can transfer values from spreadsheet 1 to spreadsheet 2 or vice versa.  This is the most efficient way to

eliminate all differences.  Your Excel worksheet is perfectly updated very quickly

The Navigator form is divided into two parts.  The upper part shows all differences per pair of

worksheets, the lower part displays the details
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Actions

The navigator can perform the following actions:

Overview of differences

Synchronize worksheets / transfer differences

Delete unwanted differences

Show/hide differences

4.3.1 Overview

In the upper part of the Navigator, the worksheets and their differences are displayed.  At one glance

you can see how many differences exist

 

For example in that screenshot you can see that the following differences were detected in worksheet

"FDM":

Missing columns 1/1; (one missing column in Master and one missing column in Update)

Missing rows 23/31; (23 missing rows in Master and 31 missing rows in Update)

Different values/

formulas

79 different formulas/values

In the columns of the list box various differences are shown.  The difference types are as follows

Missing columns

Missing rows

Duplicate keys (only database mode)

Duplicate records (redundant records, only database mode)

Different cell values/formulas

Different cell formats (only displayed by formatting comparison)

You can view the detailed information for each difference by clicking on the difference your

interested in.  The detailed information will appear in the lower part of the form

Description of the icons in the toolbar

Re-compare worksheets

With these buttons you can repeat the comparison the worksheets without closing the

Navigator.  This comes very handy when wanting to update differences and to know whether
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or not there are still differences.  If all worksheets are to be compared, the left icon must be

locked.  If this symbol is not locked, however, only the selected worksheet will be compared.

 With the right icon, a new comparison is started
Highlight / remove differences

With the left symbol differences are highlighted.  With the right icon, the Synkronizer high-

lighting's are removed, with the original background colors restored

Show/hide differences

With these two symbols the differences can be shown or hidden.  To view specific

differences, proceed as follows:

1. Press the arrow of the left icon and select the differences you want to be shown/hidden

2. Click the plus sign of the left of the symbol; the differences will be shown/hidden

3. When all differences are to be shown again, click the right button again

Arrange windows

With these two button you can change between a horizontal and a vertical view

Dock Navigator form

Normally, the navigator form is shown above the Excel worksheets.  With these buttons you

can dock the Navigator form at the left or right of the Excel worksheets

4.3.2 Detail Information

In the lower part of the form, the details are displayed, which were selected in the upper part:

 

With that list-box you can transfer, update or delete unwanted differences.  The following buttons are

available

Transfer missing rows from 1st to 2nd worksheet

With these buttons you can transfer the missing rows from the 1st to the 2nd worksheet (from

left to right).  Either all or only the selected row will be transferred.  Once the row has been

transferred, it is shown in red

These commands are also available in different columns

Transfer missing rows from 2nd to 1st worksheet
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Same function as above

Delete missing rows of 1st worksheet

With these buttons you can delete the missing rows of the 1st worksheet.  Either all or only

the selected line will be deleted

These commands are available in different columns, duplicate keys and duplicate records

Delete missing rows of 2nd worksheet

same function as above

Transfer cell differences from 1st to 2nd worksheet

With these buttons you can transfer different cell values, formulas or formats from the 1st to

the 2nd file (transfer from left to right).  There will be transferred either all or only the

selected cell difference. Once the cell difference was transferred, it is shown in red

These commands are also available in different cell formats

Transfer cell differences from 2nd to 1st worksheet

same function as above

Sort cell differences

The cell differences are by default sorted by rows and within rows by columns. Use this

button to change the sorting

This command is also available in different cell formats

Group cell differences

Each cell difference is individually presented.  When you click this button, the cell differences

in each row or column are grouped (depending on the sorting, see above).  This comes very

handy when you want to transfer all cell differences of a column with one click

This command is also available in different cell formats

Show/hide grouped cell differences

If the cell differences are grouped, the "Details Icon" is displayed.  Use this button to show or

hide the cell differences within the columns and rows

This command is also available in different cell formats

Differences which are displayed with a @-character

If a cell contains a text (string) that can be interpreted as a number, date or boolean variable (True/

False) a @: indicator is shown. E.g. the number 123 formatted as text is shown @:123.
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5 Project File

5.1 FileFormat

The Project file is a simple XML text file that can be edited with any standard text editor such as

notepad.

When manually editing XML files be aware that the names of tags are Case-sensitive. Misspelling will

cause failures.

Tip:

prepare your project using the Synkronizer  form, save it, then edit it to suit your needs.

This is the layout of the file for a project where sheets are auto matched, without any options set for

any of the pairs.

You'll notice that there are no individual pairs listed inside the <Pairs> tag..

<?xml version="1.0" standalone="yes"?>
<Synkronizer>
   <Project ID="1">
      <Settings>
         <CompareType>0</CompareType>
         <Formats>0</Formats>
         <Filters>0</Filters>
         <FilterTolerance>0</FilterTolerance>
         <FilterPattern/>
         <ReportType>0</ReportType>
         <HighlightType>1</HighlightType>
         <ShowHide>0</ShowHide>
      </Settings>
      <Files>
         <Filename0>C:\Folder\SubFolder\File 1.xls</Filename0>
         <Filename1>C:\Folder\SubFolder\File 2.xls</Filename1>
      </Files>
      <Pairs>
         <MatchType>1</MatchType>
         <MatchInclude>2</MatchInclude>
      </Pairs>
   </Project>
</Synkronizer>

For a project where pairs have individual settings the file will look like this:

(MatchType will be set to 0 as soon as you set a pair option such as RangeAddr or DBKeys.)

The pair tags must be sequentially numbered via the ID attribute.

<?xml version="1.0" standalone="yes"?>
<Synkronizer>
   <Project ID="1">
      <Settings>
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         <CompareType>0</CompareType>
         <Formats>0</Formats>
         <Filters>0</Filters>
         <FilterTolerance>0</FilterTolerance>
         <FilterPattern/>
         <ReportType>0</ReportType>
         <HighlightType>1</HighlightType>
         <ShowHide>0</ShowHide>
      </Settings>
      <Files>
         <Filename0>C:\Folder\SubFolder\File 1.xls</Filename0>
         <Filename1>C:\Folder\SubFolder\File 2.xls</Filename1>
      </Files>
      <Pairs>
         <MatchInclude>3</MatchInclude>
         <MatchType>0</MatchType>
         <PairCount>3</PairCount>
         <Pair ID="1">
            <SheetName0>Addresses</SheetName0>
            <SheetName1>Addresses</SheetName1>
         </Pair>
         <Pair ID="2">
            <SheetName0>Controlling</SheetName0>
            <SheetName1>Controlling</SheetName1>
            <RangeAddr0>$A$4:$AC$75</RangeAddr0>
            <RangeAddr1>$A$4:$AC$75</RangeAddr1>
            <DBRow>5</DBRow>
            <DBKeys>1</DBKeys>
            <DBOptionsMask>14</DBOptionsMask>
         </Pair>
         <Pair ID="3">
            <SheetName0>Budget</SheetName0>
            <SheetName1>Budget</SheetName1>
         </Pair>
      </Pairs>
   </Project>
</Synkronizer>

6 Problems / Errors

6.1 Problems / Errors

If you should have problems with the software (error messages, unable to activate, etc.), please

proceed as follows:

1. Open a new e-mail without entering any content

2. Start the Synkronizer application

3. Select Project » Help » About
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4. Double-click with the mouse on the red Synkronizer symbol.

A diagnostics file will then be created on the desktop of your pc. Attach this file to the e-mail.

5. Open the following directory

C:\Program Files\Synkronizer\Synkronizer 10.0

and attach  the file License.xml to the e-mail.

6. Send the files to support@synkronizer.com together with any further comments or observations you

may have. Please include information about your set-up (e.g., network, Citrix server, terminal server,

subnets, etc.) to help in the evaluation and resolution of the problem.

During business days, you will get an answer from our support team within 24 hours.

6.2 Known Problems / Errors

Synkronizer 10.0 is installed but does not appear on the toolbar (under tools) or on the

ribbon(under review)

The most likely cause is that Synkronizer ended up under "Disabled addins". This may happen is you

stop (or crash) excel while Synkronizer is busy. 

Proceed as follows to re-enable Synkronizer:

Excel 2007 / 2010

1. Click the Microsoft Office Button image, click Excel Options, and then click Add-Ins.

2. Check if Synkronizer 10.0 is listed under "Disabled Application Add-ins" (it should be listed under

"Active Application Add-ins").

3. Select & remove Synkronizer from the disabled category. It will then appear in either "Active

Application Add-ins" or "Inactive Application Add-ins". 

If it is listed under "inactive" then go to the ComAddin dropdown and activate it.

Excel 2003
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1. Select Help » About Microsoft Office Excel » Disabled Items

2. Select the Synkronizer add-in and click Enable

3. Re-start Excel 2003

Excel XP (and also Excel 2003)

1. Close Excel

2. Start RegEdit.exe

3. Select the following folder:

Excel XP: HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Excel\Resiliency

Excel 2003: HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Excel\Resiliency

4. If there is a key there called "DisabledItems" then remove the entire key or the items it contains.

You could create a Registry file (.reg) to do this... 

1. Start notepad (or any text editor)

2. Cut and Paste the block of code below

3. Save the file on your desktop with a .REG file extension

4. Double-click the saved file (you must have administor rights due to the changes under HKLM)

Windows Registry Editor Version 5.00

;REMOVE ALL DISABLED ITEMS
[-HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Excel\Resiliency\DisabledItems]
[-HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Excel\Resiliency\DisabledItems]
[-HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Excel\Resiliency\DisabledItems]
[-HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\Excel\Resiliency\DisabledItems]
;REMOVE THE ADDIN LOAD COMMAND FROM HKCU
[-HKEY_CURRENT_USER\Software\Microsoft\Office\Excel\Addins\Synkronizer.Connect]

;ADD THE ADDIN LOAD COMMANDS TO HKLM
;for 32bit windows
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\Excel\Addins\Synkronizer.Connect]
"FriendlyName"="Synkronizer 10.0"
"Description"="Tool for finding and managing differences."
"LoadBehavior"=dword:00000003
"CommandLineSafe"=dword:00000000
;for 64bit windows
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Office\Excel\Addins\Synkronizer.Connect]
"FriendlyName"="Synkronizer 10.0"
"Description"="Tool for finding and managing differences."
"LoadBehavior"=dword:00000003
"CommandLineSafe"=dword:00000000

Language data is not found

If you work with Windows 7 or Windows Vista, it may occur, that not all language data will be displayed.

The reason is that Windows saves automatically the data in the following hidden folder:
C:\Users\User-XY\AppData\Local\VirtualStore\Program Files (x86)\Synkronizer

You must remove this directory and then re-install Synkronizer, after that the latest language data is
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visible.

WMI (Windows Management Instrumentation) service is not installed or not working

If you get this error you'll need to verify that WMI service is installed and runs properly. Please run/

install the following utilities:

WMI Diagnosis Utility:

http://www.microsoft.com/downloads/details.aspx?familyid=d7ba3cd6-18d1-4d05-b11e-

4c64192ae97d&displaylang=en

WMI Repair Instructions:

http://windowsxp.mvps.org/repairwmi.htm

Known Error Messages

Microsoft Visual Basic Invalid Picture

Object library invalid or contains references to object definitions that could not be found

Cannot run macro 'RibbonOnLoad'. The macro may not be available in this workbook or all macros

may be disabled

These errors usually occur when not all Microsoft Office updates are correctly installed and/or

Microsoft Office is corrupted. Please download and install all Microsoft Office updates

http://office.microsoft.com/officeupdate/

and test if the problems are solved. If not you will have to re-install Microsoft Office

How to disable hyperlink warning messages

These articles describes how to disable warning messages about potentially dangerous hyperlinks in

Office 2007/2003 programs

Office 2007: http://support.microsoft.com/kb/925757

Office 2003: http://support.microsoft.com/kb/829072

Problems with Excel 4.0 Macros

You receive an error message when you open a workbook that contains XLM macros

Excel 2003: http://support.microsoft.com/kb/820739/en
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7 Visual Basic for Applications (VBA)

7.1 Introduction

Synkronizer 10 has a new feature to load and save project files which for many 9.5 users means they

will no longer need to write their own code.

For those that do need to process recurring, standardized and or complex comparisons synkronizer's

functionality can be accessed

with Visual Basic for Applications (VBA).

YOU MUST HAVE A LICENSED DEVELOPER EDITION TO ACCESS SYNKRONIZER FUNCTIONS

To access the automation functionality of Synkronizer you must obtain a reference to the Application

Object of the ComAddin. Then you will need the Application.ActiveProject to start working.

We've provided 2 simple "wrapper" functions to simplify you work which we'll also use in following

examples.

1. Ensure Synkronizer 10 Developer Edition is installed.

2. Start Excel

3. Open a (new) workbook

4. Open the VB Editor (Keyboard Shortcut Alt-F11)

5. Select your workbook in the Project Explorer window

6. Select menu Tools/References,  scroll to 'Synkronizer 10.0 Object Library', check it, and press ok.

7. Select menu Insert/Module

8. Copy the following code:

Function SynkApplication() As Synkronizer.Application

  'Wrapper to retrieve the Application object
  With Excel.Application.COMAddIns("Synkronizer.Connect")

    'Ensure the addin is connected.
    If Not .Connect Then .Connect = True
    
    Set SynkApplication = .Object.Application
  End With

  'Display progress in Excel's status bar.
  SynkApplication.DisplayStatus = True
End Function

Function SynkProject() As Synkronizer.Project

  'Wrapper to retrieve the ActiveProject
  If Not SynkApplication Is Nothing Then
    Set SynkProject = SynkApplication.ActiveProject
  End If
End Function

Note:
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The programmatic identifier used for the ComAddin is "synkronizer.connect"

The Synkronizer.Application is a child of the ComAddins(progid).Object

When you attempt to access the application object with a Free or Professional edition, "Nothing" is

returned and a messagebox is displayed.

Examples.

7.2 Examples

Option Explicit

'---------------------------------------------------------

'Requires a Reference to 'Synkronizer 10.0 Object Library'

'---------------------------------------------------------

Const FILE0 As String = "D:\Documents\TestFile1.xlsx"
Const FILE1 As String = "D:\Documents\TestFile2.xlsx"

Function SynkApplication() As Synkronizer.Application

  'Wrapper to retrieve the Application object
  With Excel.Application.COMAddIns("Synkronizer.Connect")

    'Ensure the addin is connected.
    If Not .Connect Then .Connect = True

    'Return the application
    Set SynkApplication = .Object.Application
  End With
 

  'Display progress in Excel's status bar.
  SynkApplication.DisplayStatus = True
End Function

Function SynkProject() As Synkronizer.Project

  'Wrapper to retrieve the ActiveProject
  If Not SynkApplication Is Nothing Then
    Set SynkProject = SynkApplication.ActiveProject
  End If
End Function

'-----------------------------------------------------------

'Example 1

'Compare sheets "Addresses", highlight differences.

Public Sub Example1()
  Dim oProj As Synkronizer.Project
  
  Set oProj = SynkProject
  If oProj Is Nothing Then Exit Sub
  
  With oProj
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    .Files.Load FILE0, FILE1
    With .Pairs
      .Add "Addresses", "Addresses"
    End With
    With .Settings
      .CompareType = syCompareFormulas
      .Formats = 0
      .Filters = 0
      .HighlightType = syHighlight
      .ReportType = syReportNone
      .ShowHide = syShowHideENABLED + syHideRowsIden
     End With
    .ArrangeWindows
    .Execute
    
    MsgBox .Results.SummaryMessage, vbOKOnly + vbInformation, "Synkronizer"
    .Unload CloseFiles:=True, DisplayUndo:=False
  End With
End Sub

'-----------------------------------------------------------

'Example 2

'Compare all sheets, highlight differences.

Public Sub Example2()
  Dim oProj As Synkronizer.Project
  
  Set oProj = SynkProject
  If oProj Is Nothing Then Exit Sub
  
  With oProj
    .Files.Load FILE0, FILE1
    With .Pairs

      'Ignore empty, hidden or protected sheets
      .MatchInclude = 0
      .MatchType = syMatchAllByName
      .AddMatched
    End With
    With .Settings
      .CompareType = syCompareFormulas
      .Formats = 0

      'Non-strict: Ignore Case, Whitespace and Type differences
      .Filters = syFiltersENABLED + syFiltersCase + syFiltersTrim + syFiltersType
      .HighlightType = syHighlightWithReset
      .ReportType = syReportNone
      .ShowHide = 0
    End With
    .ArrangeWindows
    .Execute
    
    MsgBox .Results.SummaryMessage, vbOKOnly + vbInformation, "Synkronizer"
    .Unload CloseFiles:=False, DisplayUndo:=False
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  End With
End Sub

'-----------------------------------------------------------

'Example 3

'Compare first sheets, create a report

Public Sub Example3()
  Dim oProj As Synkronizer.Project
  
  Set oProj = SynkProject
  If oProj Is Nothing Then Exit Sub
  
  With oProj
    .Files.Load FILE0, FILE1
    With .Pairs
      .MatchInclude = 0
      .MatchType = syMatchFirstByName
      .AddMatched
    End With
    With .Settings
      .CompareType = syCompareFormulas
      .Formats = 0
      .Filters = 0
      .HighlightType = syHighlightNone
      .ReportType = syReportStandard
      .ShowHide = 0
    End With
    .Execute
    .ReportWorkbook.Windows(1).WindowState = xlNormal
    
    MsgBox .Results.SummaryMessage, vbOKOnly + vbInformation, "Synkronizer"
    .Unload CloseFiles:=True
  End With
End Sub

'-----------------------------------------------------------

'Example 4

'Database comparison, highlight differences

Public Sub Example4()
  Dim oProj As Synkronizer.Project
  
  Set oProj = SynkProject
  If oProj Is Nothing Then Exit Sub
  
  With oProj
    .Files.Load FILE0, FILE1
    With .Pairs
      .Add "Addresses", "Addresses"
    End With



Visual Basic for Applications (VBA) 73

©2000-2014 XL Consulting GmbH, Switzerland

    

    'define database options
    With .Pairs(1)
      .DBRow = 1

      'define primary key columns (of 1st file)
      .DBKeys = "2;3"
      .DBOptions(syDatabaseGroup) = True
    End With
    
    With .Settings
      .CompareType = syCompareFormulas
      .Formats = 0
      .Filters = syFiltersENABLED + syFiltersCase + syFiltersTrim + syFiltersType
      .HighlightType = syHighlight
      .ReportType = syReportNone
      .ShowHide = 0
     End With
    .ArrangeWindows
    .Execute
    
    MsgBox .Results.SummaryMessage, vbOKOnly + vbInformation, "Synkronizer"
    .Unload CloseFiles:=True, DisplayUndo:=False
  End With
End Sub

'-----------------------------------------------------------

'Example 5

'Compare one "master" file against a series of "updates"

Sub Example5()
  Dim oProj As Synkronizer.Project
  Dim sFolderNew As String
  Dim sFolderRep As String
  Dim sFileMaster As String
  Dim aFiles() As String
  Dim i As Integer
  Dim sFile As String
  Dim sFileNew As String
  Dim sFileRep As String
  Dim n(1) As Long
  

  'define master file and folders
  'must end with backslash!
  sFileMaster = "D:\Documents\Old\Master.xlsx"
  sFolderNew = "D:\Documents\New\"
  sFolderRep = "D:\Documents\Reports\"
  
  Debug.Assert Len(Dir(sFolderNew, vbDirectory))
  Debug.Assert Len(Dir(sFolderRep, vbDirectory))
    

  'read "new" files
  i = 1
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  sFile = Dir(sFolderNew & "*.xls*")
  Do While Len(sFile) > 0
    ReDim Preserve aFiles(1 To i)
    aFiles(i) = sFile
    i = i + 1
    sFile = Dir
  Loop
  

  'loop all files
  For i = 1 To UBound(aFiles)
    sFileNew = sFolderNew & aFiles(i)
    sFileRep = sFolderRep & "Difference Report " & aFiles(i)
    sFileRep = Left(sFileRep, InStrRev(sFileRep, ".") - 1) & ".xlsx"
      
    Set oProj = SynkProject
    With oProj
      With .Settings
        .CompareType = syCompareFormulas
        .Formats = 0
        .Filters = 0
        .HighlightType = syHighlightNone
        .ShowHide = 0
        .ReportType = syReportStandard
      End With
    
      .Files.Load sFileMaster, sFileNew
      With .Pairs
        .MatchInclude = 0
        .MatchType = syMatchFirstByName
        .AddMatched
      End With
      
      .Execute
      
      If .Results.Sum Then
        n(1) = n(1) + 1
        If Len(Dir(sFileRep)) > 0 Then Kill sFileRep
        .ReportWorkbook.Close True, sFileRep
      Else
        n(0) = n(0) + 1
        .ReportWorkbook.Close False
      End If
    
      .Unload CloseFiles:=True
    End With
    Set oProj = Nothing
  Next i

  MsgBox "finished" & vbLf & _
    n(0) & " workbooks without differences" & vbLf & _
    n(1) & " workbooks with differences, see reports", _
    vbOKOnly + vbInformation, "Synkronizer"
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End Sub

'-----------------------------------------------------------

'Example 6

'compare all files with the same names of two folders

'a difference report will be created for each set of files. The differences are highlighted.

Sub Example6()
  Dim oProj As Synkronizer.Project
  Dim sFile As String
  Dim aFiles() As String
  Dim i As Integer
  Dim sFolderOld As String
  Dim sFolderNew As String
  Dim sFolderRep As String
  Dim sFileOld As String
  Dim sFileNew As String
  Dim sFileRep As String
  Dim sWorkbooks(0 To 1) As String
  Dim n(0 To 1) As Long
  

  'define folders

  'must end with backslash!
  sFolderOld = "D:\Documents\Old\"
  sFolderNew = "D:\Documents\New\"
  sFolderRep = "D:\Documents\Reports\"
  
  Debug.Assert Len(Dir(sFolderOld, vbDirectory))
  Debug.Assert Len(Dir(sFolderNew, vbDirectory))
  Debug.Assert Len(Dir(sFolderRep, vbDirectory))
  

  'read "old" files
  i = 1
  sFile = Dir(sFolderOld & "*.xls*")
  Do While Len(sFile) > 0
    ReDim Preserve aFiles(1 To i)
    aFiles(i) = sFile
    i = i + 1
    sFile = Dir
  Loop
  

  'loop all "old" files
  For i = 1 To UBound(aFiles)
    sFileOld = sFolderOld & aFiles(i)
    sFileNew = sFolderNew & aFiles(i)
    sFileRep = sFolderRep & "Difference Report " & aFiles(i)
    sFileRep = Left(sFileRep, InStrRev(sFileRep, ".") - 1) & ".xlsx"
  

    'check if "new" is there
    If Len(Dir(sFileNew)) > 0 Then
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      Set oProj = SynkProject
      With oProj
        
        With .Settings
          .CompareType = syCompareFormulas
          .Formats = 0
          .Filters = 0
          .HighlightType = syHighlight
          .ShowHide = 0
          .ReportType = syReportStandard
        End With
        
        .Files.Load sFileOld, sFileNew
        With .Pairs
          .MatchInclude = 0
          .MatchType = syMatchFirstByName
          .AddMatched
        End With
        
        .Execute
        
        If .Results.Sum Then
          n(1) = n(1) + 1
          If Len(Dir(sFileRep)) > 0 Then Kill sFileRep
          .ReportWorkbook.Close True, sFileRep
        Else
          n(0) = n(0) + 1
          .ReportWorkbook.Close False
        End If
        

        'store workbook names
        sWorkbooks(0) = .Files.Workbook(0).Name
        sWorkbooks(1) = .Files.Workbook(1).Name
        

        'close project
        .Unload CloseFiles:=False
      End With
      Set oProj = Nothing
        

      'save and close workbooks
      With Application
        .DisplayAlerts = False
        .Workbooks(sWorkbooks(0)).Close SaveChanges:=True
        .Workbooks(sWorkbooks(1)).SaveAs sFileNew
        .Workbooks(sWorkbooks(0)).Close SaveChanges:=False
        .DisplayAlerts = True
      End With

    End If
  Next i
  
  MsgBox "finished" & vbLf & _
    n(0) & " workbooks without differences" & vbLf & _
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    n(1) & " workbooks with differences, see reports", _
    vbOKOnly + vbInformation, "Synkronizer"

End Sub

'-----------------------------------------------------------

'Example 7

'compare all files with the same names of two folders

'a log file with the total differences of each file pair will be created

Sub Example7()
  Dim oProj As Synkronizer.Project
  Dim sFile As String
  Dim aFiles() As String
  Dim i As Integer
  Dim sFolderOld As String
  Dim sFolderNew As String
  Dim sFolderLog As String
  Dim sFileOld As String
  Dim sFileNew As String
  Dim sFileLog As String
  Dim n(1) As Long
  Dim t0 As Date
  

  'define folders

  'must end with backslash!
  sFolderOld = "D:\Documents\Old\"
  sFolderNew = "D:\Documents\New\"
  sFolderLog = "D:\Documents\Log\"
  
  Debug.Assert Len(Dir(sFolderOld, vbDirectory))
  Debug.Assert Len(Dir(sFolderNew, vbDirectory))
  Debug.Assert Len(Dir(sFolderLog, vbDirectory))
  
  t0 = Timer
  

  'create log file
  sFileLog = sFolderLog & "\synkronizer_log.txt"
  Open sFileLog For Output As #1
  Print #1, "Synkronizer Logfile"
  Print #1, "-------------------"
  Print #1, ""
  Print #1, "Date: " & Format(Date, "YYYY-MM-DD")
  Print #1, "Time: " & Format(Time, "hh:nn:ss")
  Print #1, ""
  Print #1, "Filepair" & vbTab & "Differences"
  
  

  'read "old" files
  i = 1
  sFile = Dir(sFolderOld & "*.xls*")
  Do While Len(sFile) > 0
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    ReDim Preserve aFiles(1 To i)
    aFiles(i) = sFile
    i = i + 1
    sFile = Dir
  Loop
  

  'loop all "old" files
  For i = 1 To UBound(aFiles)
    sFileOld = sFolderOld & aFiles(i)
    sFileNew = sFolderNew & aFiles(i)
  

    'check if "new" is there
    If Len(Dir(sFileNew)) > 0 Then
      
      Set oProj = SynkProject
      With oProj
        
        With .Settings
          .CompareType = syCompareFormulas
          .Formats = 0
          .Filters = 0
          .HighlightType = syHighlightNone
          .ShowHide = 0
          .ReportType = syReportNone
        End With
        
        .Files.Load FILE0, FILE1
        With .Pairs
          .MatchInclude = 0
          .MatchType = syMatchFirstByName
          .AddMatched
        End With
        .Execute
        
        Print #1, aFiles(i) & vbTab & .Results.Sum
        
        .Unload CloseFiles:=True
      End With
      
      Set oProj = Nothing
    Else
      Print #1, aFiles(i) & vbTab & "error"
    End If
      
  Next i
  
  Print #1, ""
  Print #1, "Comparison time: " & Format(Timer - t0, " 00.00\s\")
  Close
  
  MsgBox "finished" & vbLf & _
    UBound(aFiles) & " files compared, see log file", _
    vbOKOnly + vbInformation, "Synkronizer"
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End Sub

'-----------------------------------------------------------

'Example 8

'compare all files with the same names of two folders

'does the following:

'1) highlight differences

'2) creates a difference report of each filepair

'3) creates a log file with the total differences of each file pair

Sub Example8()
  Dim oProj As Synkronizer.Project
  Dim sFile As String
  Dim aFiles() As String
  Dim i As Integer
  Dim sFolderOld As String
  Dim sFolderNew As String
  Dim sFolderRep As String
  Dim sFolderLog As String
  Dim sFileOld As String
  Dim sFileNew As String
  Dim sFileRep As String
  Dim sFileLog As String
  Dim sWorkbooks(0 To 1) As String
  Dim n(0 To 1) As Long
  Dim t0 As Date
  

  'define folders

  'must end with backslash!
  sFolderOld = "D:\Documents\Old\"
  sFolderNew = "D:\Documents\New\"
  sFolderRep = "D:\Documents\Reports\"
  sFolderLog = "D:\Documents\Log\"
  
  Debug.Assert Len(Dir(sFolderOld, vbDirectory))
  Debug.Assert Len(Dir(sFolderNew, vbDirectory))
  Debug.Assert Len(Dir(sFolderRep, vbDirectory))
  Debug.Assert Len(Dir(sFolderLog, vbDirectory))
  
  t0 = Timer
  

  'create log file
  sFileLog = sFolderLog & "\synkronizer_log.txt"
  Open sFileLog For Output As #1
  Print #1, "Synkronizer Logfile"
  Print #1, "-------------------"
  Print #1, ""
  Print #1, "Date: " & Format(Date, "YYYY-MM-DD")
  Print #1, "Time: " & Format(Time, "hh:nn:ss")
  Print #1, ""
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  Print #1, "Filepair" & vbTab & "Differences"
  
  

  'read "old" files
  i = 1
  sFile = Dir(sFolderOld & "*.xls*")
  Do While Len(sFile) > 0
    ReDim Preserve aFiles(1 To i)
    aFiles(i) = sFile
    i = i + 1
    sFile = Dir
  Loop
  

  'loop all "old" files
  For i = 1 To UBound(aFiles)
    sFileOld = sFolderOld & aFiles(i)
    sFileNew = sFolderNew & aFiles(i)
    sFileRep = sFolderRep & "Difference Report " & aFiles(i)
    sFileRep = Left(sFileRep, InStrRev(sFileRep, ".") - 1) & ".xlsx"
  

    'check if "new" is there
    If Len(Dir(sFileNew)) > 0 Then
      
      Set oProj = SynkProject
      With oProj
        
        With .Settings
          .CompareType = syCompareFormulas
          .Formats = 0
          .Filters = 0
          .HighlightType = syHighlight
          .ShowHide = 0
          .ReportType = syReportStandard
        End With
        
        .Files.Load sFileOld, sFileNew
        With .Pairs
          .MatchInclude = 0
          .MatchType = syMatchFirstByName
          .AddMatched
        End With
        
        .Execute
        
        If .Results.Sum Then
          n(1) = n(1) + 1
          If Len(Dir(sFileRep)) > 0 Then Kill sFileRep
          .ReportWorkbook.Close True, sFileRep
        Else
          n(0) = n(0) + 1
          .ReportWorkbook.Close False
        End If
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        Print #1, aFiles(i) & vbTab & .Results.Sum
        

        'store workbook names
        sWorkbooks(0) = .Files.Workbook(0).Name
        sWorkbooks(1) = .Files.Workbook(1).Name
        

        'close project
        .Unload CloseFiles:=False
      End With
      Set oProj = Nothing
        

      'save and close workbooks
      With Application
        .DisplayAlerts = False
        .Workbooks(sWorkbooks(0)).Close SaveChanges:=True
        .Workbooks(sWorkbooks(1)).SaveAs sFileNew
        .Workbooks(sWorkbooks(0)).Close SaveChanges:=False
        .DisplayAlerts = True
      End With

    Else
      Print #1, aFiles(i) & vbTab & "error"
    End If
  Next i
  
  Print #1, ""
  Print #1, "Comparison time: " & Format(Timer - t0, " 00.00\s\")
  Close
  
  MsgBox "finished" & vbLf & _
    n(0) & " workbooks without differences" & vbLf & _
    n(1) & " workbooks with differences, see reports", _
    vbOKOnly + vbInformation, "Synkronizer"

End Sub

8 Object Model Reference

8.1 Application Object

8.1.1 Application Object

Top level object. Entry point for all automation.

Remarks

The application object is only accessible when you have a licensed Developer Edition

Example

To gain access to the Application and the ActiveProject in VBA you should do following:.
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Dim synAdd As Office.ComAddin
Dim synApp As Synkronizer.Application
Dim synProject As Synkronizer.Project
 
'set the comaddin object
Set synAdd = Application.ComAddins("synkronizer.connect")
'ensure the comaddin is connected
If not synAdd.Connect then synAdd.Connect = True 
'set the application
Set synApp = synAdd.Object
'set the project
Set synProject = synApp.ActiveProject
 

See Also

Application Object

Application Object Members

8.1.2 Application Object Members

Methods

Name Description

Properties

Name Description

ActiveProject Project that is currently active.

DisplayStatus Determines if Progress is displayed on status bar during execution.

Customer Returns the name of the licensed customer.

EditionName Returns the name of the licensed synkronizer edition.

VersionName Returns the version and build number of the application.

Events

Name Description

8.1.3 Properties

8.1.3.1 ActiveProject Property

Project that is currently active. Read Only .

Syntax

expression.ActiveProject 

expression. A variable representing a Application object.
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See Also

Application Object

Application Object Members

8.1.3.2 DisplayStatus Property

Returns or sets a boolean that determines if progress is displayed in Excel's status bar during

execution.

Syntax

expression.DisplayStatus 

expression. A variable representing a Application object.

See Also

Application Object

Application Object Members

8.1.3.3 Customer Property

Returns the name of the licensed customer. Read Only .

Syntax

expression.Customer 

expression. A variable representing a Application object.

See Also

Application Object

Application Object Members

8.1.3.4 EditionName Property

Returns the name of the licensed synkronizer edition. Read Only .

Syntax

expression.EditionName 

expression. A variable representing a Application object.

See Also

Application Object

Application Object Members
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8.1.3.5 VersionName Property

Returns the version and build number of the application. Read Only .

Syntax

expression.VersionName 

expression. A variable representing a Application object.

See Also

Application Object

Application Object Members

8.2 Project Object

8.2.1 Project Object

The project is the central object for working with Synkronizer.

See Also

Project Object

Project Object Members

8.2.2 Project Object Members

Methods

Name Description

Load Loads the specified projectfile into memory.

Save Saves the project's configuration to the specified path.

Unload Unloads the current project. Optionally closes the files

Execute Executes the compare process.

DoReport Creates a Report specified in ReportType settings.

DoHighlight Performs Highlighting specified in HighlightType settings.

DoShowHide Performs ShowHide specified in ShowHide settings.

UndoHighlight Undoes changes made by DoHighlight

UndoShowHide Undoes changes made by DoShowHide

Reset Resets specified objects or results.

ProtectionRemove Removes protection for pairs that have protected worksheets using the 

PasswordList

ProtectionValidate Verifies that protected worksheets in pairs can be unprotected with current 

PasswordList

ArrangeWindows Arranges (tiles) windows for the active Files

SelectPairSheets Activates the worksheets of the ActivePair
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Properties

Name Description

FullName The full path and name of the project file.

Name The name of the project file.

ReportWorkbook Report workbook (when created).

Settings Container for all Settings of the project.

Files Container for the Files (workbooks) of the project.

Pairs Container for the Pairs (worksheets) of the project.

Results Container for the (combined) Results of all Pairs.

ActivePair Pair that is currently active.

Events

Name Description

Progress Raised during compare execution to indicate running subprocess.

PairActivate Raised when is Pair is activated.

PairDeactivate Raised before a Pair is deactivated.

8.2.3 Methods

8.2.3.1 Load Method

Loads the specified projectfile into memory.

Syntax

expression.Load(ProjectFilePath)

expression. A variable representing a Project object.

Parameters

Name Type Description

ProjectFilePath String Path and file name of the project file. (File extension is '.xml').

Return Value

none

Remarks

If another project is active it will be unloaded first.

See Also

Project Object

Project Object Members



Synkronizer 1086

©2000-2014 XL Consulting GmbH, Switzerland

8.2.3.2 Save Method

Saves the project's configuration to the specified path.

Syntax

expression.Save(ProjectFilePath)

expression. A variable representing a Project object.

Parameters

Name Type Description

ProjectFilePath String Path and file name of the project file. (File extension is '.xml').

Return Value

none

See Also

Project Object

Project Object Members

8.2.3.3 Unload Method

Unloads the project results. Optionally closes the workbooks(without saving!)

Syntax

expression.Unload(CloseFiles,DisplayUndo)

expression. A variable representing a Project object.

Parameters

Name Type Description

CloseFiles Boolean Closes the compared files (workbooks).

DisplayUndo Boolean Optional. When True and Highlighting or ShowHide is active

then the user will be given the option to undo

Return Value

none

Remarks

If you want the files to be saved (with possible highlighting and showhide) then you must do so before

the Unload method is called.

See Also

Project Object
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Project Object Members

8.2.3.4 Reset Method

Resets specified objects or results.

Syntax

expression.Reset(eReset)

expression. A variable representing a Project object.

Parameters

Name Type Description

eReset syResetType Constant specifying which objects and variables should be

reset.

Return Value

none

See Also

Project Object

Project Object Members

8.2.3.5 Execute Method

Executes the compare process.

Syntax

expression.Execute(ActivePairOnly)

expression. A variable representing a Project object.

Parameters

Name Type Description

ActivePairOnly Boolean When True only the ActivePair is processed.

Return Value

none

Remarks

Includes the actions (DoReport, DoHighlight and DoShowHide) specified in related Settings.

.

See Also
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Project Object

Project Object Members

8.2.3.6 DoReport Method

Creates a Report specified in ReportType settings.

Syntax

expression.DoReport(ActivePairOnly)

expression. A variable representing a Project object.

Parameters

Name Type Description

ActivePairOnly Boolean Optional. When True only the ActivePair is processed.

Return Value

none

See Also

Project Object

Project Object Members

8.2.3.7 DoHighlight Method

Performs Highlighting specified in HighlightType settings.

Syntax

expression.DoHighlight(ActivePairOnly)

expression. A variable representing a Project object.

Parameters

Name Type Description

ActivePairOnly Boolean Optional. When True only the ActivePair is processed.

Return Value

none

See Also

Project Object

Project Object Members
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8.2.3.8 DoShowHide Method

Performs ShowHide specified in ShowHide settings.

Syntax

expression.DoShowHide(ActivePairOnly)

expression. A variable representing a Project object.

Parameters

Name Type Description

ActivePairOnly Boolean Optional. When True only the ActivePair is processed.

Return Value

none

See Also

Project Object

Project Object Members

8.2.3.9 UndoHighlight Method

Undoes changes made by DoHighlight

Syntax

expression.UndoHighlight(ActivePairOnly)

expression. A variable representing a Project object.

Parameters

Name Type Description

ActivePairOnly Boolean Optional. When True only the ActivePair is processed.

Return Value

none

See Also

Project Object

Project Object Members

8.2.3.10 UndoShowHide Method

Undoes changes made by DoShowHide
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Syntax

expression.UndoShowHide(ActivePairOnly)

expression. A variable representing a Project object.

Parameters

Name Type Description

ActivePairOnly Boolean Optional. When True only the ActivePair is processed.

Return Value

none

See Also

Project Object

Project Object Members

8.2.3.11 ProtectionRemove Method

Removes protection for pairs that have protected worksheets using the PasswordList

Syntax

expression.ProtectionRemove(ActivePairOnly)

expression. A variable representing a Project object.

Parameters

Name Type Description

ActivePairOnly Boolean Optional. When True only the ActivePair is processed.

Return Value

none

See Also

Project Object

Project Object Members

8.2.3.12 ProtectionValidate Method

Verifies that protected worksheets in pairs can be unprotected with current PasswordList

Syntax

expression.ProtectionValidate 

expression. A variable representing a Project object.
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Return Value

Returns a Boolean value

See Also

Project Object

Project Object Members

8.2.3.13 ArrangeWindows Method

Arranges (tiles) windows for the active Files

Syntax

expression.ArrangeWindows 

expression. A variable representing a Project object.

Return Value

none

Remarks

Minimizes windows of all other workbooks.

See Also

Project Object

Project Object Members

8.2.4 Properties

8.2.4.1 Settings Property

Container for all Settings of the project. Read Only Settings object.

Syntax

expression.Settings 

expression. A variable representing a Project object.

See Also

Project Object

Project Object Members
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8.2.4.2 Files Property

Container for the Files (workbooks) of the project. Read Only Files object.

Syntax

expression.Files 

expression. A variable representing a Project object.

See Also

Project Object

Project Object Members

8.2.4.3 Pairs Property

Container for the Pairs (worksheets) of the project. Read Only Pairs object.

Syntax

expression.Pairs 

expression. A variable representing a Project object.

See Also

Project Object

Project Object Members

8.2.4.4 Results Property

Container for the (combined) Results of all Pairs. Read Only Results object.

Syntax

expression.Results 

expression. A variable representing a Project object.

See Also

Project Object

Project Object Members

8.2.4.5 ActivePair Property

Pair that is currently active. Pair object.

Syntax

expression.ActivePair(oPair)
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expression. A variable representing a Project object.

Parameters

Name Type Description

oPair Pair Pair to be activated.

See Also

Project Object

Project Object Members

8.2.4.6 FullName Property

The full path and name of the project file. Read Only String value.

Syntax

expression.FullName 

expression. A variable representing a Project object.

See Also

Project Object

Project Object Members

8.2.4.7 Name Property

The name of the project file. Read Only String value.

Syntax

expression.Name 

expression. A variable representing a Project object.

See Also

Project Object

Project Object Members

8.2.4.8 ReportWorkbook Property

Report workbook (when created). Read Only Workbook object.

Syntax

expression.ReportWorkbook 

expression. A variable representing a Project object.
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See Also

Project Object

Project Object Members

8.2.5 Events

8.2.5.1 Progress Event

Raised during compare execution to indicate running subprocess.

Remarks

You can use this event to show progress indicator to the user.

See Also

Project Object

Project Object Members

8.2.5.2 PairActivate Event

Raised when is Pair is activated.

Remarks

You can use this event to select the pair's worksheets.

See Also

Project Object

Project Object Members

8.2.5.3 PairDeactivate Event

Raised before a Pair is deactivated.

See Also

Project Object

Project Object Members
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8.3 Settings Object

8.3.1 Settings Object

Container for a group of properties that specify how files will be compared and what actions will be

performed.

See Also

Settings Object

Settings Object Members

8.3.2 Settings Object Members

Methods

Name Description

DefaultsLoad Loads user preferences.

DefaultsSave Saves settings as user preference.

DefaultsReset Removes user preference, reloads default values.

Properties

Name Description

CompareType Returns or sets a constant specifying which content property to compare.

CompareDescription Returns a descriptive text for the CompareType

Formats Returns or sets a series of options specifying which formatting properties to

compare.

FormatsOption Returns or sets the specified formats compare option.

FormatsDescription Returns a descriptive text for the enabled Formats options.

Filters Returns or sets a series of options specifying which differences to filter

(ignore).

FiltersOption Returns or sets the specified filter option.

FiltersDescription Returns a descriptive text for the enabled Filters options.

FilterPattern Returns or sets a pattern for either Regex of Like filtering of string

differences.

FilterTolerance Returns or sets a number below which numeric differences will be ignored.

ReportType Returns or sets a constant specifying which Report to create.

HighlightType Returns or sets a constant specifying which Highlighting to perform.

HighlightDescription Returns a descriptive text for the HighlightType

ShowHide Returns or sets a series of options specifying which group of Rows and

Columns to Show or Hide.

ShowHideOption Returns or sets the specified ShowHide option.

ShowHideDescription Returns a descriptive text for the enabled ShowHide options.
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Events

Name Description

8.3.3 Methods

8.3.3.1 DefaultsLoad

Loads user preferences.

Syntax

expression.DefaultsLoad 

expression. A variable representing a Settings object.

Return Value

none

See Also

Settings Object

Settings Object Members

8.3.3.2 DefaultsSave

Saves settings as user preference.

Syntax

expression.DefaultsSave 

expression. A variable representing a Settings object.

Return Value

none

See Also

Settings Object

Settings Object Members

8.3.3.3 DefaultsReset

Removes user preference, reloads default values.

Syntax

expression.DefaultsReset 

expression. A variable representing a Settings object.
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Return Value

none

See Also

Settings Object

Settings Object Members

8.3.4 Properties

8.3.4.1 CompareType

Returns or sets a constant specifying which content property to compare. syCompareType constant.

Syntax

expression.CompareType 

expression. A variable representing a Settings object.

See Also

Settings Object

Settings Object Members

8.3.4.2 CompareDescription

Returns a descriptive text for the CompareType Read Only String value.

Syntax

expression.CompareDescription 

expression. A variable representing a Settings object.

See Also

Settings Object

Settings Object Members

8.3.4.3 Formats

Returns or sets a series of options specifying which formatting properties to compare. syFormatsFlag

constant.

Syntax

expression.Formats 
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expression. A variable representing a Settings object.

Remarks

If the ENABLED flag is not set all other flags are ignored.

See Also

Settings Object

Settings Object Members

8.3.4.4 FormatsOption

Returns or sets the specified formats compare option. Boolean value.

Syntax

expression.FormatsOption(Flag)

expression. A variable representing a Settings object.

Parameters

Name Type Description

Flag syFormatsFla

g

(Series of) Flag(s) specifying a group of formatting

properties to compare.

Remarks

If the ENABLED flag is not set all other flags are ignored.

See Also

Settings Object

Settings Object Members

8.3.4.5 FormatsDescription

Returns a descriptive text for the enabled Formats options. Read Only String value.

Syntax

expression.FormatsDescription 

expression. A variable representing a Settings object.

See Also

Settings Object

Settings Object Members
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8.3.4.6 Filters

Returns or sets a series of options specifying which differences to filter (ignore). syFiltersFlag constant.

Syntax

expression.Filters 

expression. A variable representing a Settings object.

Remarks

If the ENABLED flag is not set all other flags are ignored.

See Also

Settings Object

Settings Object Members

8.3.4.7 FiltersOption

Returns or sets the specified filter option. Boolean value.

Syntax

expression.FiltersOption(Flag)

expression. A variable representing a Settings object.

Parameters

Name Type Description

Flag syFiltersFlag (Series of) Flag(s) specifying which differences to ignore.

Remarks

If the ENABLED flag is not set all other flags are ignored.

See Also

Settings Object

Settings Object Members

8.3.4.8 FiltersDescription

Returns a descriptive text for the enabled Filters options. Read Only String value.

Syntax

expression.FiltersDescription 

expression. A variable representing a Settings object.
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See Also

Settings Object

Settings Object Members

8.3.4.9 FilterPattern

Returns or sets a pattern for either Regex of Like filtering of string differences. String value.

Syntax

expression.FilterPattern 

expression. A variable representing a Settings object.

Remarks

Must begin with either "r:" or "l:".

See Also

Settings Object

Settings Object Members

8.3.4.10 FilterTolerance

Returns or sets a number below which numeric differences will be ignored. Double value.

Syntax

expression.FilterTolerance 

expression. A variable representing a Settings object.

See Also

Settings Object

Settings Object Members

8.3.4.11 ReportType

Returns or sets a constant specifying which Report to create. syReportType constant.

Syntax

expression.ReportType 

expression. A variable representing a Settings object.

See Also



Object Model Reference 101

©2000-2014 XL Consulting GmbH, Switzerland

Settings Object

Settings Object Members

8.3.4.12 HighlightType

Returns or sets a constant specifying which Highlighting to perform. syHighlightType constant.

Syntax

expression.HighlightType 

expression. A variable representing a Settings object.

See Also

Settings Object

Settings Object Members

8.3.4.13 HighlightDescription

Returns a descriptive text for the HighlightType Read Only String value.

Syntax

expression.HighlightDescription 

expression. A variable representing a Settings object.

See Also

Settings Object

Settings Object Members

8.3.4.14 ShowHide

Returns or sets a series of options specifying which group of Rows and Columns to Show or Hide. 

syShowHideFlag constant.

Syntax

expression.ShowHide 

expression. A variable representing a Settings object.

Remarks

If the ENABLED flag is not set all other flags are ignored.

See Also

Settings Object
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Settings Object Members

8.3.4.15 ShowHideOption

Returns or sets the specified ShowHide option. Boolean value.

Syntax

expression.ShowHideOption(Flag)

expression. A variable representing a Settings object.

Parameters

Name Type Description

Flag syShowHideFl

ag

(Series of) Flag(s) specifying the group of rows or columns.

Remarks

If the ENABLED flag is not set all other flags are ignored.

See Also

Settings Object

Settings Object Members

8.3.4.16 ShowHideDescription

Returns a descriptive text for the enabled ShowHide options. Read Only String value.

Syntax

expression.ShowHideDescription 

expression. A variable representing a Settings object.

See Also

Settings Object

Settings Object Members

8.4 Files Object

8.4.1 Files Object

Container for the two Files (workbooks) to compare.

See Also
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Files Object

Files Object Members

8.4.2 Files Object Members

Methods

Name Description

Load Loads the two files from disk.

Properties

Name Description

FileName Returns the full path and filename of either of the Files.

IsValid Returns True if both Files are loaded and can be compared.

Workbook Returns the workbook object of either of the files.

Window Returns the window object of either of the files.

Events

Name Description

8.4.3 Methods

8.4.3.1 Load Method

Loads the two files from disk.

Syntax

expression.Load(FileName0,FileName1)

expression. A variable representing a Files object.

Parameters

Name Type Description

FileName0 String Full path for 1st file (also called Master).

FileName1 String Full path for 2nd file (also called Update).

Return Value

none

See Also

Files Object

Files Object Members
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8.4.4 Properties

8.4.4.1 FileName Property

Returns the full path and filename of either of the Files. Read Only String value.

Syntax

expression.FileName(MUid)

expression. A variable representing a Files object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Files

See Also

Files Object

Files Object Members

8.4.4.2 IsValid Property

Returns True if both Files are loaded and can be compared. Read Only Boolean value.

Syntax

expression.IsValid 

expression. A variable representing a Files object.

See Also

Files Object

Files Object Members

8.4.4.3 Workbook Property

Returns the workbook object of either of the files. Read Only Workbook object.

Syntax

expression.Workbook(MUid)

expression. A variable representing a Files object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Files
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See Also

Files Object

Files Object Members

8.4.4.4 Window Property

Returns the window object of either of the files. Read Only Window object.

Syntax

expression.Window(MUid)

expression. A variable representing a Files object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Files

See Also

Files Object

Files Object Members

8.5 Pairs Object

8.5.1 Pairs Object

Collection of Pair objects.

Remarks

You can add pairs individually with the Add Method or use the AddMatched method to automatically

add pairs for all worksheets that have matching names or indexes. 

 

You can retrieve a specific pair with Pairs(Index) or Pairs.Item(index)

You can remove a specific pair with Pairs.Remove(Index)

You can remove all pairs by using the ResetPairs Method

.

See Also

Pairs Object

Pairs Object Members
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8.5.2 Pairs Object Members

Methods

Name Description

Add Adds a pair to the Pairs collection.

AddMatched Creates Pairs for all "matched" worksheets.

Remove Removes specified Pair from the Collection.

ResetPairs Resets specified objects and properties from Pairs.

Properties

Name Description

Item Returns a single item (Pair) from the collection.

Exists Returns True if specified ID or Index exists in the collection.

Count Returns the number of members in the collection.

MatchInclude Returns or sets options specifying types of worksheets to include by 

AddMatched method.

MatchIncludeOption Returns or sets options specifying types of worksheets to include by 

AddMatched method.

MatchType Returns or sets a constant specifying how worksheets will be matched by 

AddMatched method.

PasswordList Returns or sets a semicolon delimited list of passwords needed to access

protected sheets.

Events

Name Description

8.5.3 Methods

8.5.3.1 Add Method

Adds a pair to the Pairs collection.

Syntax

expression.Add(SheetName0,SheetName1)

expression. A variable representing a Pairs object.

Parameters

Name Type Description

SheetName0 String A name or index of a worksheet. (must exist in Master).

SheetName1 String A name or index of a worksheet. (must exist in Update).

Return Value

Returns a Pair object
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See Also

Pairs Object

Pairs Object Members

8.5.3.2 AddMatched Method

Creates Pairs for all "matched" worksheets.

Syntax

expression.AddMatched 

expression. A variable representing a Pairs object.

Return Value

none

Remarks

Matching depends on MatchType and MatchInclude

See Also

Pairs Object

Pairs Object Members

8.5.3.3 Remove Method

Removes specified Pair from the Collection.

Syntax

expression.Remove(Index)

expression. A variable representing a Pairs object.

Parameters

Name Type Description

Index Variant A valid ID or Index for the Pair.

Return Value

none

See Also
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Pairs Object

Pairs Object Members

8.5.3.4 ResetPairs Method

Resets specified objects and properties from Pairs.

Syntax

expression.ResetPairs(eReset)

expression. A variable representing a Pairs object.

Parameters

Name Type Description

eReset syResetType

Return Value

none

See Also

Pairs Object

Pairs Object Members

8.5.4 Properties

8.5.4.1 Item Property

Returns a single item (Pair) from the collection. Pair object.

Syntax

expression.Item(Index)

expression. A variable representing a Pairs object.

Parameters

Name Type Description

Index Variant A valid ID or Index for the Pair.

See Also

Pairs Object

Pairs Object Members
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8.5.4.2 Count Property

Returns the number of members in the collection. Long value.

Syntax

expression.Count 

expression. A variable representing a Pairs object.

See Also

Pairs Object

Pairs Object Members

8.5.4.3 Exists Property

Returns True if specified ID or Index exists in the collection. Boolean value.

Syntax

expression.Exists(Index)

expression. A variable representing a Pairs object.

Parameters

Name Type Description

Index Variant A valid ID or Index for the Pair.

See Also

Pairs Object

Pairs Object Members

8.5.4.4 PasswordList Property

Returns or sets a semicolon delimited list of passwords needed to access protected sheets. String

value.

Syntax

expression.PasswordList 

expression. A variable representing a Pairs object.

See Also

Pairs Object

Pairs Object Members
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8.5.4.5 MatchInclude Property

Returns or sets options specifying types of worksheets to include by AddMatched method.

syMatchIncludeFlag constant.

Syntax

expression.MatchInclude 

expression. A variable representing a Pairs object.

See Also

Pairs Object

Pairs Object Members

8.5.4.6 MatchType Property

Returns or sets a constant specifying how worksheets will be matched by AddMatched method.

syMatchType constant.

Syntax

expression.MatchType 

expression. A variable representing a Pairs object.

See Also

Pairs Object

Pairs Object Members

8.6 Pair Object

8.6.1 Pair Object

Container for a pair of worksheets to compare.

Remarks

Specify a Range 

Normally the entire data range of the sheet is used, but you set the range using the RangeAddr

property.

Compare as Database 

You can compare the sheets as databases when

· your data is organized in a tabular layout, with descriptive headers above each column. 

· rows can be uniquely identified by a primary key.

 

You must set the primary key using the DBKeys property.

You can specify the starting row of the database with the DBRow property. 
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When you want the records sorted or the results grouped, use DBOptions .

.

See Also

Pair Object

Pair Object Members

8.6.2 Pair Object Members

Methods

Name Description

Properties

Name Description

DBRow Returns or sets the index for the row which contains the headers.

DBKeys Returns or sets a semicolon delimited list of Column indices used as primary

key for Database.

DBOptions Returns or sets options for sorting or grouping database records.

RangeAddr Returns or sets an optional Range address for the specified member of the

pair.

SheetName Returns the name of the worksheet for the specified member of the pair.

Sheet Returns the Worksheet object for the specified member of the pair.

Range Returns the Range object for the specified member of the pair.

Results Returns the number of differences found.

ID Returns the key of the Pair object in the Pairs collection.

Index Returns the index of the Pair object in the Pairs collection.

IsDB Returns True when DBKeys property is (correctly) specified. Pair will be

compared as database.

Highlighted Returns True when differences in the Pair are currently Highlighted and can

be Undone.

Events

Name Description

Progress Raised during compare execution to indicate running subprocess.

8.6.3 Properties

8.6.3.1 DBRow Property

Returns or sets the index for the row which contains the headers. Long value.

Syntax
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expression.DBRow 

expression. A variable representing a Pair object.

Example

This example defines the 3rd row as database heading.

With oProj.Pairs(1)

   'row number of database heading
   .DBRow = 3

   'create primary key; column no. of master
   .DBKeys = "2;3"

   'group records
   .DBOptions(syDatabaseGroup) = True
End With

See Also

Pair Object

Pair Object Members

8.6.3.2 DBKeys Property

Returns or sets a semicolon delimited list of Column indices used as primary key for Database. String

value.

Syntax

expression.DBKeys 

expression. A variable representing a Pair object.

Remarks

The column no. of the primary keys of the Master file have to be entered, separated by semicolons.

Example

To use the 2nd and 3rd column as primary key.

With oProj.Pairs(1)

   'row number of database heading
   .DBRow = 3

   'create primary key; column no. of master
   .DBKeys = "2;3"

   'group records
   .DBOptions(syDatabaseGroup) = True
End With

See Also
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Pair Object

Pair Object Members

8.6.3.3 DBOptions Property

Returns or sets options for sorting or grouping database records. Boolean value.

Syntax

expression.DBOptions 

expression. A variable representing a Pair object.

Example

This example groups the records.

With oProj.Pairs(1)

   'row number of database heading
   .DBRow = 3

   'create primary key; column no. of master
   .DBKeys = "2;3"

   'group records
   .DBOptions(syDatabaseGroup) = True
End With

See Also

Pair Object

Pair Object Members

8.6.3.4 RangeAddr Property

Returns or sets an optional Range address for the specified member of the pair. String value.

Syntax

expression.RangeAddr(MUid)

expression. A variable representing a Pair object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair

Example

This example sets the range address.

With .Pairs
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   .Add "db1", "db1"
   .Item(1).RangeAddr(muMaster) = "A1:H50"
   .Item(1).RangeAddr(muUpdate) = "A1:H50"
End With

See Also

Pair Object

Pair Object Members

8.6.3.5 SheetName Property

Returns the name of the worksheet for the specified member of the pair. Read Only String value.

Syntax

expression.SheetName(MUid)

expression. A variable representing a Pair object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair

See Also

Pair Object

Pair Object Members

8.6.3.6 Sheet Property

Returns the Worksheet object for the specified member of the pair. Read Only Worksheet object.

Syntax

expression.Sheet(MUid)

expression. A variable representing a Pair object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair

See Also
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Pair Object

Pair Object Members

8.6.3.7 Range Property

Returns the Range object for the specified member of the pair. Read Only Range object.

Syntax

expression.Range(MUid)

expression. A variable representing a Pair object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair

Remarks

To change the Range use the RangeAddr property.

See Also

Pair Object

Pair Object Members

8.6.3.8 Results Property

Returns the number of differences found. Read Only Results object.

Syntax

expression.Results 

expression. A variable representing a Pair object.

See Also

Pair Object

Pair Object Members

8.6.3.9 ID Property

Returns the key of the Pair object in the Pairs collection. Read Only String value.

Syntax

expression.ID 

expression. A variable representing a Pair object.
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See Also

Pair Object

Pair Object Members

8.6.3.10 Index Property

Returns the index of the Pair object in the Pairs collection. Read Only Long value.

Syntax

expression.Index 

expression. A variable representing a Pair object.

See Also

Pair Object

Pair Object Members

8.7 Results Object

8.7.1 Results Object

Container for the number of differences found.

Remarks

The Project returns the combined results. Each Pair returns individual results.

See Also

Results Object

Results Object Members

8.7.2 Results Object Members

Methods

Name Description

Properties

Name Description

MissingTabs Returns the number of Missing Sheets (auto matching only).

MissingCols Returns the number of Missing Columns (or Fields).

MissingRows Returns the number of Missing Rows (or Records).
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DuplicateKeys Returns the number of Duplicate Keys (database only).

DuplicateRecords Returns the number of Duplicate Records (database only).

DifferentContent Returns the number of Cells with Different Content.

DifferentFormats Returns the number of Cells with Different Formats.

Sum Returns the total number of differences found.

SumByCode Returns the number of specified differences found.

SummaryMessage Returns the results as a formatted text for messagebox.

TextDisplay Returns the number of specified differences found as text.

Events

Name Description

8.7.3 Properties

8.7.3.1 MissingTabs Property

Returns the number of Missing Sheets (auto matching only). Read Only Long value.

Syntax

expression.MissingTabs(MUid)

expression. A variable representing a Results object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair

See Also

Results Object

Results Object Members

8.7.3.2 MissingCols Property

Returns the number of Missing Columns (or Fields). Read Only Long value.

Syntax

expression.MissingCols(MUid)

expression. A variable representing a Results object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair
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See Also

Results Object

Results Object Members

8.7.3.3 MissingRows Property

Returns the number of Missing Rows (or Records). Read Only Long value.

Syntax

expression.MissingRows(MUid)

expression. A variable representing a Results object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair

See Also

Results Object

Results Object Members

8.7.3.4 DuplicateKeys Property

Returns the number of Duplicate Keys (database only). Read Only Long value.

Syntax

expression.DuplicateKeys(MUid)

expression. A variable representing a Results object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair

See Also

Results Object

Results Object Members
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8.7.3.5 DuplicateRecords Property

Returns the number of Duplicate Records (database only). Read Only Long value.

Syntax

expression.DuplicateRecords(MUid)

expression. A variable representing a Results object.

Parameters

Name Type Description

MUid muMasterUp

dateID

Selects either member of the Pair

See Also

Results Object

Results Object Members

8.7.3.6 DifferentContent Property

Returns the number of Cells with Different Content. Read Only Long value.

Syntax

expression.DifferentContent 

expression. A variable representing a Results object.

See Also

Results Object

Results Object Members

8.7.3.7 DifferentFormats Property

Returns the number of Cells with Different Formats. Read Only Long value.

Syntax

expression.DifferentFormats 

expression. A variable representing a Results object.

See Also

Results Object

Results Object Members
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8.7.3.8 Sum Property

Returns the total number of differences found. Read Only Long value.

Syntax

expression.Sum 

expression. A variable representing a Results object.

See Also

Results Object

Results Object Members

8.7.3.9 SumByCode Property

Returns the number of specified differences found. Read Only Long value.

Syntax

expression.SumByCode(ResultCode,MUid)

expression. A variable representing a Results object.

Parameters

Name Type Description

ResultCode syResultCode Constant selects group of results to return.

MUid muMasterUp

dateID

Optional. Leave blank to return combined results.

See Also

Results Object

Results Object Members

8.7.3.10 SummaryMessage Property

Returns a formatted text that can be used in a messagebox. Read Only String.

Syntax

expression.SummaryMessage 

expression. A variable representing a Results object.

See Also

Results Object
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Results Object Members

8.7.3.11 TextDisplay Property

Returns the number of specified differences found as text. Read Only String value.

Syntax

expression.TextDisplay(ResultCode)

expression. A variable representing a Results object.

Parameters

Name Type Description

ResultCode syResultCode Constant selects group of results to return.

See Also

Results Object

Results Object Members

8.8 Enumerations

8.8.1 muMasterUpdateID

Constants used to identity the member of a set or pair.

Name Description

muMaster Selects the 1st member of the set. NOTE: value is 0).

muUpdate Selects the 2nd member of the set. NOTE: value is 1).

8.8.2 syCompareType

Constants used by the CompareType property in Settings.

Name Description

syCompareFo

rmulas

The Formula property of the cells are compared.

syCompareVa

lues

The Value2 property of the cells are compared.

8.8.3 syReportType

Constants used by the ReportType property in Settings.

Name Description

syReportNon No report is created.
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e

syReportStan

dard

A workbook is created, range addresses are plain text.

syReportHype

rLinks

A workbook is created, range addresses are hyperlinks to the original document.

syReportXML An xml files is created, uses XSL transformation. Needs IE and MSXML.

8.8.4 syHighlightType

Constants used by the HighlightType property in Settings.

Name Description

syHighlightN

one

Differences are not Highlighted.

syHighlight Differences are Highlighted. No Cell coloring for all cells if not removed before

processing.

syHighlightW

ithReset

Differences are Highlighted. Cell coloring for all cells is removed before processing.

8.8.5 syFormatsFlag

Constants used to by the the Formats property in Settings.

Name Description

syFormatsEN

ABLED

Enable or Disable all other Formats options.

syFormatsNu

mber

Compare Number (Numberformat) properties of cells.

syFormatsAli

gnment

Compare Alignment properties of cells.

syFormatsFon

t

Compare Font properties of cells.

syFormatsBor

der

Compare Border properties of cells.

syFormatsPat

tern

Compare Pattern (Interior/Fill) properties of cells.

syFormatsPro

tection

Compare Protection properties of cells.

8.8.6 syFiltersFlag

Constants used to by the the Filters property in Settings.

Name Description

syFiltersENAB Enable or Disable all other Filters options.
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LED

syFiltersCase Text compare Case Insensitive. "ABC" vs "abc" will not result in a differences.

syFiltersTrim Text compare Trim text. "ABC " vs "ABC" will not result in a differences.

syFiltersType Differences in Datatype are ignored. Use to ignore differences between Date values

and String values representing Dates.

syFiltersConst

ant

All constants are ignored. Only formulas are compared.

syFiltersForm

ula

All formulas are ignored. Only constants are compared.

syFiltersHidC

ols

Data in Hidden Columns will be ignored.

syFiltersHidR

ows

Data in Hidden Rows will be ignored.

8.8.7 syShowHideFlag

Constants used to by the the ShowHide property in Settings.

Name Description

syShowHideEN

ABLED

Enable or Disable all other ShowHide options.

syHideRowsIde

n

Hide identical rows (linked, without cell differences).

syHideRowsDif

f

Hide different column: (linked, some cells are different).

syHideRowsMis

s

Hide missing rows: (not occurring in the other worksheet).

syHideRowsDu

ps

Hide rows with either duplicate keys or records.

syHideColsMiss Hide missing columns: (not occurring in the other worksheet).

8.8.8 syMatchType

List of valid types of Matching.

Name Description

syMatchManu

al

Pairs were modified or added with Add

syMatchFirstB

yName

The first Matched sheets are added.

syMatchAllBy

Name

All included sheets are matched by Name.

syMatchAllBy

Index

All included sheets are matched by Index.
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8.8.9 syMatchIncludeFlag

Flags specifying a group of sheets to include during Matching.

Name Description

syMatchInclu

deEmpty

Empty sheets will be included by AddMatched

syMatchInclu

deProtected

Protected sheets will be included by AddMatched

syMatchInclu

deHidden

Hidden sheets will be included by AddMatched

8.8.10 syDatabaseFlag

Flags for pair's DBoptions

Name Description

syDatabaseSo

rt

Records are sorted (on fields in primary key) before comparing.

syDatabaseGr

oup

Records are grouped by Result after comparing.

syDatabaseA

ddID

Adds an ID in the last column of the database to aid sorting and filtering.

8.8.11 syResultCode

Constants used by the SumByCode property in Results.

Name Description

syResultTabs Missing sheets.

syResultCols Missing columns.

syResultRows Missing rows.

syResultKeys Duplicate Keys.

syResultDups Duplicate Records.

syResultCont Different Content.

syResultFmts Different Formats.

8.8.12 syProgressID

Constants used by Progress events to identify current ly executing sub process.

Name Description

syProgressLin

kCols

Linking columns.

syProgressLin Creating row indexes.
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kData

syProgressLin

kRows

Linking row indexes.

syProgressCo

mpCells

Comparing cells.

syProgressHi

ghlight

Processing DoHighlight.

syProgressSh

owHide

Processing DoShowHide.

syProgressRe

port

Processing DoReport.

syProgressHi

ghlightUndo

Processing UnDoHighlight.

syProgressSh

owHideUndo

Processing UnDoShowHide.

syProgressUp

date

Updating cells (Navigator only).

8.8.13 syResetType

Constants used by the Reset method in Project and Pairs.

Name Description

syResetResult

s

Results are removed. May display alert if Pairs are highlighted.

syResetReleas

e

Releases an event handler monitorirng accidental closing of the workbooks.

syResetPairs All items in the pairs collection are removed.

syResetAll All settings will be removed from the project. .

8.8.14 syErrors

Constants used to identify a group of errors possibly raised during Project load.

Name Description

syErrInit Errors raised during initialization.

syErrProj Errors raised during project load. Project will not be loaded.

syErrFile Errors raised during files load. Project will not be loaded.

syErrPair Errors raised during Pairs add. Pair will not be added.

syErrProp Errors raised when setting incorrect Pair options. Pair will be added, but these options

will be ignored.
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